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1 Introduction 

flwpx can take multiple Microsoft documents, including Word documents, Excel 
spreadsheets, Microsoft Visio files and create one all-inclusive publication that can be 
shared with multiple readers. 

Furthermore, if used correctly, the publication will become editable by multiple parties 
while still retaining the original documents with the author and allowing the author full 
control on what can be edited and by whom. 

This document will show you the basics on how to create a publication, and the best way to 
create a publication and key points on how flwpx handles the basic elements of all 
documentation. This document will also show you how to create more complex publications 
as dynamic interactive documents, to get the most out of your publication. 
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2 Registering on flwpx 

To download flwpx, please visit https://www.flwpx.com/introduction. 

At the bottom of the page, there is a Download flwpx lektur button. Please click on this 
button and the download will start automatically. Please feel free to watch the video while 
waiting. To see this video please click on the Video of flwpx lektur button. Once 
downloaded, please run the .exe file. Please allow flwpx to make changes to your computer 
and accept the license agreement.  

On start-up, this registration window will automatically appear. 

 

User name: Your given name (and surname)  

Device : Something recognizable like Laptop,  Desktop, or Work PC - to distinguish it from 
other possible registrations in your name. 
Email : Your email address, Optional, but this allows other users to recognise your 
registration name as belonging to you.  Not used for any purpose other than human 
recognition.   
City : Again, for human recognition 
Password : I would suggest leaving this blank - it is not needed except for extreme 
circumstances 
Registry code : I would suggest username. This creates your flwpx address, which would 
then be Elana&flwpx (for example). Avoid using spaces. 
Do not flag the "unlisted" flag.  This will make it impossible for us to contact you at the 
current time. 

When complete, click on "Register". 

  

https://www.flwpx.com/introduction
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3 Word 

The most basic documents that flwpx can handle is Microsoft Word. The following sections, 
will explain how to make the most of your Word documents and how flwpx handles some of 
Word’s functionality. 

3.1 Table of contents: Chapters and Headings 

The flwpx viewer does not make use of 
the Table of Contents created in Word, 
this functionality therefore must not be 
included or created.  

Instead, flwpx creates a Table of Contents 
based on the level of headings used, 
where Heading 1 is assigned to a Chapter 
heading, and the Headings 2 to 9 can be 
used in descending ranking, as best suited 
to the work in your Word document. 

It is essential that the heading styles are 
only applied to actual headings. The rest 
of the text should be normal. All heading 
styles should be based on normal.  

To personalise the look of the level of 
heading chosen, in the Home ribbon, Styles (Alt+Ctrl+Shift+S) -> manage styles -> Modify.  

A consistent approach will achieve the optimum results. 

3.2 Pages 

The flwpx viewer adjusts the page size dynamically to fit the size of the device used to view 
the content. This means that pages are not fixed. In your document, when wishing to refer 
to a specific page, rather create a hyperlink to the content referred to so that it can be 
directly accessed, alternatively refer to a table/figure or chapter number. Do not specify a 
page as this will invariably be incorrect. 

3.3 Page Breaks 

The uniqueness of the flwpx viewer is that paging is managed internally and thus there is no 
use of page breaks made within lektur unless the publication needs to be printed.  When 
printing, page breaks are obeyed, so that it is possible to divide printouts at the given page 
breaks, if required. Please remember that if you permit printing, the user can print your 
document to Acrobat PDF, from which all your text can be copied. 
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Aside from printing, the flwpx viewer will ensure that headings align with their assigned 
images, tables or paragraphs, and that pages are formatted dynamically to the size of the 
screen used to display the document, which will differ from user to user.  

3.4 Images 

Currently flwpx can handle other types of image files such as .png or .bmp, but the 
explanations below use .jpg as the image type. A feature of the flwpx viewer is that images 
are presented as scalable high resolution Jpegs without having to undertake the pain of 
sizing images to fit into the Word document. Presented in the form of thumbnails in the 
media panel, these thumbnails can be flipped into the Utility panel for closer inspection by 
panning and zooming. To make use of this feature, follow these easy steps: 

o Save all the .jpg’s that are to be included in your Word document in one 
folder,  

o Label each image sensibly, so that you can at a glance determine which image 
is which, “sensible_name.jpg”, 

o In your word document place a holder at the point where you wish your 
image to be, “Sensible image”, add a short description on the next line, 

o Bookmark the placeholder with the identical name of your image preceded 
by “i” followed by an underscore, “i_”, so that for example, the placeholder 
“Sensible image” is given the bookmark “i_sensible_name” or 
“i_sensiblename”, note that the “jpg” does not form part of the bookmark as 
it denotes a file type, 

o Prefixing a bookmark with “i_” indicates to the flwpx system that a jpg file 
will be placed at the place holder. 

Word has its quirks, one is that bookmarking a placeholder can over run other text and 
cause your flwpx document to lose some of its features. This is especially prevalent when 
pressing enter after a bookmarked field. When this happens, check your bookmarks using 
the “Go To”, ensure that the bookmark encompasses only the placeholder and does not 
include the text below or further placeholders. If this has happened, copy the bookmark 
“Ctrl c” then delete the bookmark, exit the bookmark box, reassign the area of the 
placeholder, invoke the bookmark box, add the copied bookmark “Ctrl v”. 

Images specified as bookmarked text in the document will be understood to refer to a .jpg 
image file, and this image will be merged into the document during the flwpx import 
process, where the size of the thumbnail image is specified when configuring your 
document for publication.  

Remember to store your images in a subfolder of your publication. 
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4 Flwpx commands in Word 

4.1 Images 

4.1.1 i_ : Insert .jpg image 

To insert images in your publication, save your image as a jpg where the name has no 
spaces. Use an “_” instead of a space. In Word place the bookmark for the name of the 
“i_Image” over “image”. Consider using a table in Word to enhance layout. 

Jpgs and svgs are stored in a sub-folder of your publication folder. 

(See example in Word Document “Draft Publication” bookmark: “i_Colosseum”) 

4.2 Vector charts 

4.2.1 v_ : Insert vector chart with optional image icon 

To display your Visio chart within the publication you need to export your Visio file as a 
“svg”. Map linking between “svgs” aids navigation through your publication. If you would 
also to display a reduced size image of your Visio file in the publication and make it available 
for printing, export the Visio as a “jpg”. 

Jpgs and svgs are stored in a sub-folder of your publication folder. 

(See example in Word Document “Draft Publication” bookmark: “v_project_life”) 

4.3 Output cells 

4.3.1 CO_ : Output cell 

The CO_ command in word is used to output a single cell from your excel spreadsheet.  This 
can be used, for example, to complete a sentence, as follows:  

The owner of the car is CO_nameofowner and he is responsible 

The italic section above, CO_nameofowner should, of course, be a bookmark.  The label 
portion - nameofowner - should refer to an excel label which resolves to a single cell.  That 
cell can be a value or a formula, and in this case should provide the appropriate name. 

(See example in Word Document “Draft Publication” bookmark: “CO_invest_val_1”) 

4.4 Input cells 

4.4.1 CI_ : Input one cell 

If CI_is used in the word document, this denotes an input field from a single cell - i.e., for the 
command CI_inputcell, the label "inputcell" must denote a single cell in excel not containing 
a formula.  Note that as with all input cells in excel, it is important that this cell in your excel 
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workbook must not be empty.  A single space, a dot or a digit (0) is required to ensure that 
the cell exists and can be used as input. 

(See example in Word Document “Draft Publication” bookmark: “CI_issue”) 

4.4.2 CJ_ : Input full 

As with CI_, CJ_ also denotes input of a single cell, but in this case all available framed space 
is used for the input.  For practical reasons, this means that CJ_ in a word document should 
only be used within a word table, where the frame of the cell in which you place the 
command will be used as the limits of the input field.  

(See example in Word Document “Draft Publication” bookmark: “CJ_Basic_issue_shares”) 

4.4.3 CV_ : Input versioning cell 

Relates to a single cell of arbitrary size in Excel. It is labelled and then bookmarked in Word 
with the prefix “CV_”. Take cognisance on the intended size of the cell and constrain it in a 
table in Word for improved layout. The effect of the CV_ command is that the contents of 
the cell are available for editing and the edits are visible as strikethroughs and added 
content, much as in Word when “Track Changes” is enabled. 

(See example in Word Document “Draft Publication” bookmark: “CV_Version_text”) with the 
corresponding: cell in Excel Document “Draft Publication” name: “Version_text”)  

4.4.4 CDS_ : Single column display 

Relates to a single column in excel of arbitrary height. The region is labelled and then 
bookmarked in Word using the prefix “CDS_”. This column is primarily used for large text 
segments, and obeys all formatting placed on the text.  

If the column extends the length of the page, a page break will be enforced within the 
column and the column will continue on the next page. And the text within the column will 
be split accordingly. 

4.5 Attachments 

4.5.1 CF_ : Attachment field 

Provides a single attachment field in your publication for documents. Label a cell in Excel, 
bookmark in Word with a CF_Label. 

(See example in Word Document “Draft Publication” bookmark: “CF_Attachment”) 

4.5.2 CFN_ : Variable number of attachment fields 

Provides for multiple attachments in your publication for documents. Label a column in 
Excel, bookmark in Word with a CFN_Label. Only the first attachment point is visible in your 
publication, if that is filled, the next one pops up and so on until the column provided has 
been filled. 
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(See example in Word Document “Draft Publication” bookmark: “CFN_multiple_attach”) 

4.5.3 CG_ : Attachment image 

Provides a single attachment field in your publication for images. Label a cell in Excel, 
bookmark in Word with a CG_Label. In flwpx when an image is placed in this attachment 
field, the attachment field will update and the image will be displayed within the 
publication. 

4.6 Conditional commands 

4.6.1 CCE_ : Conditional Command Evaluation 

The CCE_ command in a word document (ex.: CCE_mycondition) denotes the conditional 
generation of a command bookmark.  The extension ("mycondition" in the example above) 
must denote a single cell in Excel which would, typically, contain a conditional command 
generating an actual bookmark to be used in place of the CCE_ bookmark. 

For example:  The bookmark in Word is CCE_mycondition 

The name "mycondition" in your excel spreadsheet denotes a cell which contains the 
following formula: 

=IF(C23>500,"CD_firstrange","CD_secondrange") 

The result of this command will be that if cell C23 has a value greater than 500, the actual 
command to be executed will be CD_firstrange (that is, a range of cells labeled "firstrange" 
in your spreadsheet will be displayed, see below for CD_ command) whereas if the content 
of cell C23 is not greater than 500, the command to be executed will be CD_secondrange. 

(See example in Word Document “Draft Publication” bookmark: “CCE_client_info_1”) 

4.7 Output regions 

4.7.1 CD_ : Display Excel region 

Used to display an excel named region using the prefix CD_. The region itself consist of a 
single output cell or a region with further bookmarking using flwpx prefixes such as CI_, CJ_, 
CF_, CVR_, CVC, CCE, etc. 

(See example in Word Document “Draft Publication” bookmark: “CD_check_box”) 

4.8 Text segments 

4.8.1 TS_ : Text segment start and TE_ : Text segment end 

This marks a text segment that can be flipped into the utility panel for printing. Ensure that 
the suffix is consistent related commands. 



Private and confidential  Property of regpx 

13 
 

(See example in Word Document “Draft Publication” bookmark: “TS_Certificate_1”/ 
“TE_Certificate_1”) 

4.8.2 TCS_ : Conditional text segment start and TCE_ : Conditional text segment end  

This is a conditional text segment; ie it appears when certain selections or inputs have been 
made. Additionally, it can be flipped into the utility panel for printing. 

(See example in Word Document “Draft Publication” bookmark: “TCS_Certificate_2_show”/ 
“TCE_Certificate_2_show”) 

4.8.3 TO_ : Conditional text segment output 

Is nested into an IF statement in an Excel cell which is labelled and then bookmarked in 
Word as CCE_Label. In Word the CCE_ prefix instructs flwpx to find the labelled cell in Excel 
and execute the instructions. 

(See example in Excel Document “Draft Publication” in the cell named: 
“Certificate_2_condition”, you will find the following: “TO_certificate_2_show”)  

4.9 Printing 

4.9.1 TOC_ : Table of Contents 

Place a page break at the end of the page before the Table of Contents, insert TOC_# 
bookmark on its own on the next page, force the continuation of the publication to the next 
page without using a page break. flwpx will generate a Table of Contents based on the 
headings used at print time. 

(See example in Word Document “Draft Publication” bookmark: “TOC_01”) 

4.9.2 SOP_ : Start of Print 

Place a SOP_# at the point in the publication where you wish the printable region to begin. 
This is useful for creating setup fields for an interactive publication, where these fields 
should not be printed 

(See example in Word Document “Draft Publication” bookmark: “SOP_01”) 

4.9.3 EOP_ : End of Print 

Place a EOP_# at the point in the publication where you wish the printable region to end. 
This is useful for creating setup fields for an interactive publication, where these fields 
should not be printed. 

(See example in Word Document “Draft Publication” bookmark: “EOP_01”) 

4.9.4 POL_ : Print orientation landscape 

Place a POL_# at the point in the publication where you wish the page orientation to change 
to landscape during a print, this is useful for printing extended tables 
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4.9.5 POP_ : Print orientation portrait 

Place a POP_# at the point in the publication where you wish the page orientation to change 
back to portrait during a print, after a POL_ has been used 

Note: POL_ and POP_ take effect during a second print of the document 
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5 Flwpx Commands in Excel 

5.1 Input Cell / region 

5.1.1 CI_ : Define cell / region as input 

Can be a region or a cell within a named region for providing input cells. Is limited to the size 
of the content of the cell. Blank cells do not allow for input. 

(See example in Excel Document “Draft Publication” name: “CI_address”)  

5.1.2 CJ_ : Define cell / region as full input 

As with CI_, provides for input. The size of the cell determines the limit of the input, not the 
content. Blank cells do not allow for input. 

(See example in Excel Document “Draft Publication” name: “CJ_Comment”)  

5.1.3 CK_ : Define cell / region as non-workgroup input 

Becomes an entry field in the publication. Retains its contents for the local user during 
workgroup sessions. This means that the field is not over-written by another user’s input. 

Note that the CV_ function is only available in Word 

5.1.4 CIR_ : Define cell / region as input triggering refresh 

Marking regions in Excel with a CIR_Label instructs flwpx to update the related Visio charts 
and Excel calculations in real-time. 

(See example in Excel Document “Draft Publication” name: “CIR_clear_check”)  

5.2 Reset button 

5.2.1 CR_ : Define reset button 

Create a button within a named region by labelling it CR_ABC. Please note that the CR_ 
must be followed by three characters, no more, no less. Label the region or regions, that 
exist within a named region, to be reset XX_ABC. Any number of regions can be reset by 
inserting 01, 02 etc XX_01_ABC, XX_02_ABC. This in effect can create global reset for your 
publication. In Word the bookmark to display the named region is then CD_named_region. 

(See example in Excel Document “Draft Publication” name: “CR_ROL”)  

(See example in Excel Document “Draft Publication” name: “XX_ROL”)  

(See example in Excel Document “Draft Publication” name: “Director_assignment_table”)  

(See example in Excel Document “Draft Publication” name: 
“CD_Director_assignment_table”) 
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5.3 Conditional Row / Column 

5.3.1 CVR_ : Conditionally exclude row  

CVR_Name relates to a Cell “Name” that resolves as TRUE, FALSE using an IF statement. 
Where the name of the cell “Name” is then used with the prefix CVR_ to name a spanned 
region (ie. end to end horizontally) within a named region that. It can be used multiple times 
using 01, 02 ie CVR_01_Name, CVR_02_Name, and so on. 

(See example in Excel Document “Draft Publication” name: “CVR_Clear_all”)  

5.3.2 CVC_ : Conditionally exclude column 

CVC_Name relates to a cell “Name” that resolves as TRUE, FALSE using an IF statement. 
Where the name of the cell “Name” is then used with the prefix CVC_ to name a spanned 
region (ie. end to end vertically) within a named region that. It can be used multiple times 
using 01, 02 ie CVC_01_Name, CVC_02_Name, and so on. CVC_01_Control_quarter_119 

(See example in Excel Document “Draft Publication” name: “CVC_01_Control_quarter_119”)  

5.3.3 CCE_ : Apply the command of a nominated cell to a region  

CCE_Name in Excel will evaluate a nominated cell “Name” to determine the actual 
command to be executed. The area covered by CCE_Label need not span the horizontal or 
vertical axis of the named region. 

For example: 

Label a cell or region as CCE_mycond. 

In a cell labelled mycond, place the following conditional: 

=IF(C23>300,”CD_firstregion”,”CD_secondregion”) 

This will result in a cell region display (CD_) of firstregion if cell C23 is greater than 300, and 
of secondregion otherwise. 

The derived command in either case can be any valid command.  If, for example, no 
command should be executed in the false case, it is fine to just place a blank string (“”) in 
the else (false) clause. 

 (See example in Excel Document “Draft Publication” name: “CCE_01_April_19_Edit”)  

5.4 Attachment cell 

5.4.1 CF_ : Define attachment cell 

Is a cell within a named region that provides for attachment functionality for documents, 
cannot be blank, insert text such as “drop attachment here”. 
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(See example in Excel Document “Draft Publication” name: “CF_sow_pclient_1”)  

Note that the CG_ and CFN_ functions is only available in Word. 

5.5 Hyperlink 

5.5.1 CH_ : Define publication hyperlink 

Naming a cell with the prefix CH_ provides for linking to the named area in Word sans 
prefix. 

(See example in Word Document “Draft Publication” name: “Contract”)  

(See example in Excel Document “Draft Publication” name: “CH_Contract”)  

(See example in Excel Document “Draft Publication” name: “Contract_link”)  

(See example in Word Document “Draft Publication” name: “CD_Contract_link”)  

5.6 User privileges 

5.6.1 CLE_ relates to editing rights per user 

Only used in Excel. 

This prefix, CLE_XX, applies editing rights to sheet XX based on a TRUE/FALSE cell that is 
written at the time of issuing the license in flwpx. If at licensing the recipient is given editing 
rights on sheet XX, the cell is set to TRUE by flwpx and the recipient can edit the regions that 
refer to the CLE. If the recipient receives no editing rights, flwpx sets the cell to FALSE and 
the regions become view only. This means that the editing rights of any cell or range of cells 
on any sheet can be managed and controlled using the prefix CCE_, a label for a cell with 
instructions, and a CLE_ cell. 

(See example in Excel Document “Draft Publication” name: “CLE_01”)  

5.6.2 CLV_ relates to viewing rights per user 

Only used in Excel, for Visio blocks. 

This prefix, CLV_XX, applies editing rights to sheet XX based on a TRUE/FALSE cell that is 
written at the time of issuing the license in flwpx. If at licensing the recipient is given viewing 
rights on sheet XX, the cell is set to TRUE by flwpx and the recipient can view the map nodes 
that refer to the CLV. If the recipient receives no editing rights, flwpx sets the cell to FALSE 
and the Visio map nodes disappear. So viewing map nodes can be controller with a CLV_ 
and a CVN_ 

(See example in Excel Document “Draft Publication” name: “CLV_08”)  
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6 Flwpx commands in Visio 

6.1 Conditional Nodes 

6.1.1 CVN_ : Conditionally display Visio node 

For any Visio node, the "shape name" can be used to specify flwpx commands. 

Using a CVN_ prefix shape name denotes the node as being conditionally displayed. For 
example: 

Shape name is CVN_displaythisnode 

The extension ("displaythisnode") must be an excel label which resolves to a single cell in 
your spreadsheet.  This cell would typically have a formula such as the following: 

=IF(C23 > 400, TRUE, FALSE) 

In this case, if cell C23 has a value greater than 400, the cell "displaythisnode" resolves to 
TRUE, and the node in the Visio chart is displayed.  If the cell C23 has a value not greater 
than 400, the cell resolves to FALSE and the Visio node is not displayed. 

(See in Visio file: mini_publication_map, within group “Client_1”, the shape name of the 
chevron is “CVN_01_client_status_1”) 

6.2 Node Titles 

6.2.1 CT_ : Node title update 

If, for a Visio node, the "shape name" is specified with a CT_ prefix, this allows the title of 
the node to be determined in your excel spreadsheet. 

For example, if you specify the shape name CT_thisnodetitle, the extension "thisnodetitle" 
should be an excel label which resolves to a single cell in your spreadsheet.  This cell would 
typically have a formula such as : 

=IF(C23 > 400, "Big Value", "Smaller value") 

In this case, if cell C23 has a value greater than 400, the cell "thisnodetitle" resolves to "Big 
Value", and this becomes the displayable title of the Visio node.  In the opposite case, the 
title "Smaller value" becomes the displayable title of the node. 

 

6.3 Composite Visio commands 

It is possible to specify a Visio node as being both conditional and having an excel 
determined title.  This is achieved by specifying both commands, separated by a semicolon 
(";") 
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For example, you can specify the following shape name: 

CVN_displaythisnode;CT_thisnodetitle 

Both commands will be obeyed - the node will conditionally display, and if it displays the 
node title will be derived from the excel cell refered to in the CT_ command. 

(See in Visio file: mini_publication_map, within group “Client_1”, the shape name of the 
rectangle is “CT_person_name_1;CVN_01_client_status_1”) 
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7 Excel authoring 

7.1 Sheets Allowed per Excel File 

The first 12 sheets of an Excel file allow definition of viewing and editing rights. Note that 
Excel always numbers the sheets as per the listing sequence in the sheet tab at the bottom 
of the spreadsheet. The leftmost sheet in this tab set is sheet 1, and they number 
sequentially to the right from this sheet onward. 

For each of the first 12 sheets, the flwpx licence allows the licence issuer (author or 
publisher) to define whether that sheet may be viewed and/or edited.  In this way, it is 
possible to provide the same document to different recipients and (for example) allow up to 
12 recipients to edit distinct regions of the document, with no overlap (if so desired). 

From sheet 13 onwards, all content is automatically editable and viewable. 

For this reason, it is important to place all content with security requirements within the 
first 12 sheets. No control over content access is available beyond this limit. 

Note:  Although inter-sheet references are fully supported, off-spreadsheet references (in 
other words, references to other spreadsheets) are not supported at all.  Should a 
spreadsheet contain an off-spreadsheet reference, the last text entry generated will be 
used.   

7.2 Drop List 

To create a drop list: 

1. Create a list of options 
2. Highlight that list and name it something sensible. 
3. Select the cell you want the drop list to appear in 
4. In the excel ribbon: Data > Data Validation 
5. Select list from the drop down menu under allow 
6. Source is your named list. 
7. Click okay. 
8. Rename the cell that contains the drop down to something sensible with the prefix 

“CI_” or “CIR_” 
9. Encompass that cell with another bookmark. 
10. Duplicated that second bookmark in word with the prefix “CD_” 

7.3 Check Box 

To create a check box: 

1. In the ribbon: Developer > Insert (The briefcase icon) > Form Controls > Check box 
2. Draw the check box on your spreadsheet. 
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3. Right click on the check box > Format Control… > Cell Link: (Select the cell where you 
wish for the checkbox to appear in flwpx) 

4. Selecting and de-selecting the checkbox will change the selected cell to “TRUE” or 
“FALSE” respectively. 

5. Rename the cell that contains the TRUE/FASLE to something sensible with the prefix 
“CI_” or “CIR_” 

6. Encompass that cell with another bookmark. 
7. Duplicated that second bookmark in word with the prefix “CD_” 

 

7.4 Attachment Field 

In the excel file, name a single cell something sensible, and put some form of text within it. 

In the word document create a bookmark with the prefix “CF_” and the sensible name. This 
will change that cell to accept any attachment. 

7.5 Tables 

Create a table in your Word document 
suitable for your purposes. Bookmark 
the fields that are to be editable with 
the names of the Excel “name box” 
prefixing with “CI_” (capital c and i 
followed by an underscore, no spaces) 
to indicate that the field is for 
calculation. And in the cases which the 
editable fields are going into the 
document blank, just place a full stop in 
the editable cells, to ensure that they 
can be edited on flwpx. 

  

 
 



Private and confidential  Property of regpx 

23 
 

7.6 Inputs and Outputs Fields from Excel 

Use Excel to create editable fields in your document. Refresh will show the results of the 
entries made. Create your table with supporting calculations in Excel. Name the editable 
fields to be used in word suitably in the Excel “name box”. 

 

 

 

 

7.7 Graphs 

To include a pie chart with the results of 
the editable fields, Label your pie chart in 
your Excel spreadsheet in the Excel name 
box. Create your place holder in your 
Word document followed by a description 
on the next line. Book mark the place 
holder with the name of the pie chart 
preceded by “CD_”, no spaces. flwpx 
currently supports pie charts, bar graphs, 
line graphs, and column graphs 
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7.8 Dates 

Date updates can be made using =DATE(YEAR,MONTH,DAY) and =EDATE(DATE,MONTH). 

 When using the “DATE” functionality, create a date cell, and a cell for the number of years 
using a drop down list, then in the outcome cell call the results of the following calculation. 
Split the original date entry cell in three discrete cells, one for Year, for Month and for Day. 
Below Year call the value of the drop down list. Sum the Year and drop value. In the 
outcome cell call the summed Year, the original Month and the original Day. 

When using EDATE functionality, again create a date cell, and a drop down list for the 
number of months to be considered. In the outcome cell =EDATE(original date, drop list of 
months selected) 

7.9 Hyperlinks 

To create a hyperlink in your Excel spreadsheet or region to be incorporated into your Word 
document, insert the destination bookmark in the Address field at the bottom of the Edit 
Hyperlink dialogue box, make sure to prefix the bookmark with “WD:” with no spaces or 
underscore. 

Change the hyperlink 
style to your chosen text 
format or individually per 
linked field to ensure 
consistency, as Excel in 
default turns a hyperlink 
blue, which may not be 
your preferred choice of 
colour in your Word 
document. Right click -> 
Format cells -> Underline 
-> none -> Colour -> black 
or other choice.  

To insert a selected Excel region or graphs generated in Excel in your document:  
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o Name the graph or name of the 
selected region in the “name box” 
of your Excel spreadsheet. Name 
each graph or region sensibly, so 
that you can at a glance determine 
which graph or region belongs 
where in your document, 

o In your word document place a 
holder at the point where you wish 
your graph or region to be, 
“Sensible name”, add a short 
description on the next line, 

o Bookmark the placeholder with the identical name of your graph or region 
preceded by “CD” followed by an underscore, “CD_”, so that for example, the 
placeholder “Sensible name” is given the bookmark “CD_sensible_name” or 
“CD_sensiblename”. Note that “.xls” does not form part of the bookmark as it 
denotes a file type, 

o Prefixing a bookmark with “CD_” indicates to the flwpx system that a graph 
will be placed at the place holder. 

Word has its quirks, one is that bookmarking a placeholder can over run other text and 
cause your flwpx document to lose some of its features. This is especially prevalent when 
pressing enter after a bookmarked field. When this happens, check your bookmarks using 
the “go to”, ensure that the bookmark encompasses only the placeholder and does not 
include the text below or further placeholders. If this has happened, copy the bookmark 
“Ctrl c” then delete the bookmark, exit the bookmark box, reassign the area of the 
placeholder, invoke the bookmark box, add the copied bookmark “Ctrl v”. 

Graphs specified as bookmarked text in the document will be understood to refer to an 
Excel file, and the graph will be merged into the document during the flwpx import process, 
where the size of the thumbnail image is specified when configuring your document for 
publication. Only one Excel file supporting all the graphs or spread sheet calculations for 
your document is used and the thumbnails do not need to be generated separately.  

7.10 Reset 

There is the ability to reset values within the publication. What this means is that when you 
have a table that a user inputs numbers into and you wish to clear that information, you can 
use the reset button to remove and replace all input cells with a defined value. To do this, 
you will need to create a cell above, below or next to the table you wish to reset, and give it 
a value, for instance “0” or “0.0”, then name this cell “CR_sensible”, then select the region 
your table is in, including this cell, and name it “XX_sensible”, the XX can be whatever letters 
you want, just ensure that the letters you are using have not already been defined. Then 
select the input cells and instead of naming them “CI_name”, you will use the new prefix 
“CIR_”. And then in word you will have the bookmark “CD_XX_sensible”.  
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This reset does not just work for tables; it works for Visio files that are defined with 
conditional statements. The reset will reset the values to whatever you define as the reset 
value and resets the Visio to its original state.  

The CIR_ prefix has the additional functionality of updating the spreadsheets and Visio 
charts in real-time with the requirement for a refresh. Use this instead of CI_ or CJ_, 

7.11 Naming Cells 

Name Uniqueness: Excel allows for naming of cells or regions to be duplicated within a 
file, as these names are sheet specific within the file. flwpx requires 
that the entire excel file, which may consist of a number of sheets, 
adheres to a unique name per cell or region referenced in your Word 
document. Duplication of names for cells or regions across sheets will 
result in arbitrary display of information in your flwpx document - the 
first cell found for the given name will be used, and this is unlikely to 
be the correct cell.  Make sure that all your cells have unique names. 

7.12 Managing Bookmarks 

Now you might come across a situation where you have named something incorrectly or 
have removed the use of that bookmark and now you want to delete it from your list of 
bookmarks in excel. This isn’t a simple as it is in word, you have to make some changes to 
your ribbon. 

To find the name manager: File > Options > Customize Ribbon > Under the main tabs find 
Data and click on it > At the bottom there will be a New Group button. This will create a new 
group under the Data tab. Make sure to click on the new group that was just created, then 
on the left, scroll down till you find Name Manager, click on it and then click the Add  >> 
button to add it to the ribbon. 

In the ribbon you will now find Name Manager under Data > New Group. 

By clicking on Name Manager, a window will pop up with a list of all current bookmarks, you 
can now select, edit or delete any of the bookmarks. 

7.13 Conditionality in Excel 

7.13.1 CVR_, CVC_, and CCE_ : conditional exclusions. 

In an Excel spreadsheet, the CVR_ command is used to conditionally exclude one or more 
rows, the CVC_ command is used to conditionally exclude one or more columns from a 
spreadsheet region, and the CCE_ command is used to evaluate a nominated cell to 
determine the actual command to be executed. 

Consider the following.  In word, you have a bookmark CD_myregion.  The label myregion 
resolves to a range in your excel spreadsheet - let's say A5 through G20. 
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This would normally result in this entire region being displayed in your flwpx publication. 

Now, imagine that under certain conditions you don't want row 8 to be displayed. 

If you create a label CVR_checkrow8 and this label resolves to the range A8 .. G8, and the 
label checkrow8 resolves to a cell which has a formula : 

=IF(C23>300,TRUE, FALSE) 

If cell C23 has a value greater than 300, the cell referred to by checkrow8 resolves to TRUE, 
and row 8 displays.  If C23 has a value not greater than 300, the cell resolves to FALSE, and 
row 8 does not display. 

Note that for the CVR_ command to be considered, the range referred to by the label 
extension (checkrow8 in this case) must extend from or before the display region to at or 
after the display region - in other words, in this case for CD_myregion, it must extend from 
column 1 to at or after column 8. 

Also, note that the exclusion rows may be any number from 1 or more.  You can exclude 5 
rows in this example by defining the label checkrow8 as defining A8 .. G12. 

In the same way, a column region can be conditionally excluded using CVC_.  In this case, 
the label must resolve to a column or set of columns ranging from at or before the top of 
the display region to at least the bottom of the display region.  So, for example, if this range 
were to be A5 .. C20, columns A through C would display conditionally depending on the 
value of the referenced boolean cell. 

7.14 Managing user exclusion in Excel for Visio charts 

7.14.1 CLE_ : determining user editing rights 

If you need to be able to evaluate which editing rights the user has on a given sheet in a 
workbook, you can use the CLE_ command to obtain this value. 

In any given sheet, label any single cell using the CLE_ prefix.  For example, we can label cell 
A1 of the sheet as CLE_rights (the label extension in this case is discarded, you can use 
anything you wish). 

In this example, the current user's editing rights for this sheet will be placed in cell A1.  That 
is : if the current user has permission to edit the sheet, the value of cell A1 will become 
TRUE, otherwise false. 

7.14.2 CLV_ : determining user viewing rights 

If you need to be able to evaluate which viewing rights the user has on a given sheet in a 
workbook, you can use the CLV_ command to obtain this value. 
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In any given sheet, label any single cell using the CLV_ prefix.  For example, we can label cell 
A1 of the sheet as CLV_rights (the label extension in this case is discarded, you can use 
anything you wish). 

In this example, the current user's viewing rights for this sheet will be placed in cell A1.  That 
is : if the current user has permission to view the sheet, the value of cell A1 will become 
TRUE, otherwise false. 

7.15 Spreadsheet Prefixes 

The following bookmark prefixes are used in Word documents with specific reference to 
your spreadsheet : 

Prefix Function 

CD_ Display a cell, region or graph 

CI_ Define a single input cell 

CO_ Output the value of a cell as text 

CF_ Define an attachment cell - declares a drop region for an attachment 

CG_ Define an attachment cell for an image - image displayed after drop   

CCE_ Define a conditional cell bookmark 

CVR_ Define conditional row exclusion bookmark 

CVC_ Define conditional column exclusion bookmark 

CH_ Used within Excel to define a hyperlink into the document 

CK_ Define a machine specific cell for workgroup purposes 
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CR_ Resets a given region 

CIR_ Cells which will be affected by a reset 

In addition to the above, there is a special case when using CD_ to display a spreadsheet 
region. 

If you wish to define a given cell, column or row region within the CD_ region for input, that 
region must be “named” (the excel equivalent of a bookmark) using a CI_ prefix name. The 
actual bookmark name is not important and is not used, it can be anything unique. The only 
relevant issue is the CI_ prefix, which the parser uses to denote the named region as an 
input region. Any number of regions inside of a CD_ display region may be named for input. 
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8 Visio 

8.1 Images in Word 

A further feature of the flwpx viewer is that .svg charts or diagrams are presented as 
thumbnail .jpg’s in the flwpx document, and expanded as scalable high resolution diagrams 
which present the linking functionality saved when flipped into the utility panel for closer 
inspection by panning and zooming. To make use of this feature, follow these easy steps: 

1. Save all the Visio created diagrams that are to be included in your Word 
document individually as both .svg and .jpg in one folder. Note: If you wish to 
keep your general images and those created from Visio separate, i.e have a 
Chart and Image folder, all .jpg’s will need to go into the Image folder, 
regardless of how they originated and all .svgs will need to be kept in the 
Chart folder. 

2. Label each image sensibly, so that you can at a glance determine which 
diagram is which, “sensible_name.vsdx” and then export them as .svg and 
.jpg,  

3. To create an identical .jpg image of the chart or diagram, go File -> Export -> 
Change File Type -> JPEG File Interchange Format -> Save As, 

4. To create an identical .svg image of the chart or diagram, go File -> Export -> 
Change File Type -> SVG Scalable Vector Graphics -> Save As, 

5. In your word document place a holder at the point where you wish your 
diagram to be, “Sensible image”, click enter and add a short description on 
the next line to create a boundary for your diagram, 

6. After having clicked enter and adding a further line with a short description, 
go back to the placeholder and Bookmark it with the identical name of your 
diagram preceded by “v” followed by an underscore, “v_”, so that for 
example, the placeholder “Sensible image” is given the bookmark 
“v_sensible_name” or “v_sensiblename”, note that the neither “vsdx”, svg, 
nor “jpg” form part of the bookmark as they denote a file type, 

7. Prefixing a bookmark with “v_” indicates to the flwpx system that a jpg file in 
the form of a thumbnail will be placed at the place holder in the media panel 
and a navigable and scalable svg diagram will be available in the utility panel. 

8. It is possible to cause the display of a node in a Visio chart to be conditional.  
To achieve this, select the node, then from the Developer tab choose “Shape 
Name”.  Give the node a shape name prefixed by “CVN_”.  The name 
following the prefix must match the bookmark (name) of a Boolean cell in the 
spreadsheet.  If the cell evaluates to TRUE (1) the node will display, if FALSE 
(0) the node will not display. 

9. The title of a node can be derived from the content of a spreadsheet cell.  To 
achieve this, select the node, then from the Developer tab choose “Shape 
Name”.  Give the node a shape name prefixed by “CT_”.  The name following 
the prefix must match the bookmark (name) of a text (string) cell in the 
spreadsheet which will provide the required title. 
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Word has its quirks, one is that bookmarking a placeholder can over run other text and 
cause your flwpx document to lose some of its features. This is especially prevalent when 
pressing enter after a bookmarked field. When this happens, check your bookmarks using 
the “go to” button, ensure that the bookmark encompasses only the placeholder and does 
not include the text below or further placeholders. If this has happened, copy the bookmark 
“Ctrl c” then delete the bookmark, exit the bookmark box, reassign the area of the 
placeholder, invoke the bookmark box, add the copied bookmark “Ctrl v”. 

The diagrams created in Visio and used in the 
Word document must be saved as individual 
files where the file title (File -> Title) is the 
same as the file name assigned to the image 
pasted as an enhanced metafile into the word 
document.  

The file title and file name must be one word 
with no spaces, alternatively use “_” 
(underscore) in lieu of a space. 

All the individual diagrams created in Visio are 
saved in a separate folder as both a .vsdx, a .svg and a .jpg which is submitted together with 
the Word document to flwpx.  

Links are created in the Visio 
diagrams as Insert -> Hyperlink -> 
insert in Address the destination 
bookmark created in the Word 
document. This would typically be 
a bookmark assigned to a 
heading. 

Consistency and accuracy will 
determine the outcome of the 
quality of the links in the Word 
book. 

 

8.2 Navigational Map Links 

Another unique feature of the flwpx viewer is its ability to make use of a navigational 
overview of the entire Word document, determined by the author, to emphasize important 
aspects of the document, making it easier for the user to find the information they are 
looking for. 

This overview of the entire document and then per chapter is created in Visio and requires a 
different linking mechanism from the ones described above, as the link is intended to open 
the map in the Utility panel and the related chapter in the media panel.  
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To achieve this the hyperlink needs 
to have addresses separated by a 
colon “:”, again no spaces. The 
first address must be the 
bookmark of the Chapter 
heading, the second the 
bookmark of the map. Such as 
“childbookmark:v_childmap”. 

 

A further feature of the 
navigational mechanism is that 
one can travel down and up the 
navigational maps with a simple 
click. This is accomplished by 
including an up button in the 
child maps. Again, two 
addresses are required in the 
hyperlink separated by a colon 
“:”, no spaces, that of the parent 
chapter and then the parent 
map, such as 

“parentbookmark:v_parentmap”. 

This means in the word document, there will be two bookmarks, parentbookmark and 
v_parentmap. 

The first bookmark will move the publication to the point at which the bookmark exists and 

the second will change the map view to the correct map. 

It is possible to make the links conditional. Refer to point 8 under 5.1. 
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9 General 

9.1 Finishing 

To ensure that a Word document is ready to be sent for import into flwpx viewer, all 
changes to document must be accepted, comments deleted and the document must be 
saved as a “docx”. 

 

Both .doc and .docx are Word file 
extensions from Microsoft. The 
default file extension for Word 2007 
became docx, prior to that, the 
default file extension was doc. The 
doc file format was proprietary to 
Microsoft, limiting its readability in 
other applications. To open the 
readability of the Microsoft Word 
documents the standard was 
changed to an open format 
incorporating XML, hence the “x”. If 
you are using a version of Word 
document older than 2007, it must 
be converted to docx format before 
submitting for publication. 

 

Once you are happy with your editing and are 
ready to submit your document, complete 
the following: 

Go to “Review”, click on down arrow of 
Accept, Accept All Changes. Still in “Review”, 
click on down arrow in Delete next to New Comment, Delete All Comments in Document. 

 

9.2 Bookmarking 

Bookmarks are a critical element of incorporating the dynamic functionality into a flwpx 
document. Take the time to validate your bookmarks, here are a few tips: 
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9.2.1 Word 

A technique for validating your bookmarks: Shift +Ctrl+ 
F5 -> scroll to topmost bookmark -> Alt ‘g’, check that 
bookmark correct, scroll down one, Alt ‘g’ again and so 
on. 

 

 

9.2.2 Excel 

Highlight the cell which will be used to hyperlink to the named region, click “Hyperlink”, 
select “Place in this Document” under “Link to:”, scroll “Select a place in this document” 
down to “Defined names” branch, select the appropriate named region that you would like 
to travel to. 

Hyperlink checking: go to each link -
> Ctrl ‘k’ -> check that the “WD:” 
document bookmark is correct.  

 

 

 

 

Bookmark checking: cell or graph name checking, go to 
names tag, hit down arrow, go to each name and make 
sure that the area properly defined.  
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9.2.3 Visio 

Hyperlink checking: go to each linked item 
-> Ctrl ‘k’ -> check that the word 
document bookmark is identical to that 
entered as the hyperlink. Also, ensure that 
“Use relative path for hyperlink” is 
checked.  

 

 

9.3 Hyperlinks 

A bookmark is the destination or target, the hyperlink the journey or source. Typically, a 
heading or image of the subject in the Word document would be a bookmark, and any 
reference to that subject would be a hyperlink, either in the Word document, the selected 
Excel region, or in the Visio diagram.   

Ensure that all destinations in the 
Word document are bookmarked as 
one word with no spaces, 
alternatively use “_” (underscore) in 
lieu of a space, this same bookmark 
is then used in the hyperlink as the 
target to follow.  

Highlight the text which will be used 
to hyperlink to the bookmark, click “Hyperlink”, select “Place in this Document” under “Link 
to:”, scroll “Select a place in this document” down to “Bookmark” branch, select the 
appropriate bookmark that you would like to travel to. 

 

 

Where a heading is bookmarked 
which has a related image or diagram 
from Visio, bookmark the heading as 
normal, then use the same bookmark 
with the prefix “v_” for the image. 
This will ensure that the heading and 
image appear together when 
referenced. 
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A hyperlink in Word is default blue underlined. To modify this, create your first hyperlink, 
then select Styles, scroll down to Hyperlink, click Modify style, Modify, Select colour and de-
select underscore button (u). 

9.4 Special Characters 

|| : (two vertical bars, alone in line in a paragraph): hard line break.  The two characters 
are absorbed, and a line break is displayed in the output publication. 

This character is build using two pipe key strokes. The pipe key can be found as the caps of 
the forward slash key. Where the key is located is keyboard dependant, generally it can be 
found above the enter key (solid vertical line), otherwise somewhere along the number key 
line at the top of the keyboard (dashed vertical line). 
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10 Prefix Summary 

The following bookmark prefixes are used to create flwpx functionality. 

Prefix Description Word Excel Visio 

i_ Embed an 
image in the 
document 

i_Label, where 
Label.jpg is the name 

of the image to be 
embedded 

not used not used 

v_ Embed a 
vector chart 

in the 
document 

v_Label where 
Label.svg is the name 
of the vector chart to 

be embedded, and 
(optional) Label.jpg is 

the image to be 
displayed as a link to 

the chart in the 
document 

not used Generate a chart 
and export to 

Label.svg. 

Optionally 
generate an image 
to be presented, 
named Label.jpg 

f_ (future 
provision) 

   

CR_ Creates a 
Reset button 

not used CR_region, where 
region is the 

section of the 
spreadsheet that 
needs to be reset 

not used 

CIR_ Input cell 
which 

causes chart 
refresh and 

formula 
recalculation 
for current 

display page 

not used CIR_name, where 
name is the name 
of the cell/s that 
are input fields 

not used 
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Prefix Description Word Excel Visio 

CCE_ Conditional 
link 

CCE_Label where Label 
is the name of a 

spreadsheet cell which 
will provide the final 

bookmark. 

See note i below 

Linked from Word: 
Label is the 

bookmark (name) 
of a cell which 

itself generates a 
conditional 
bookmark. 

CCE_Label in Excel 
will evaluate a 

nominated cell to 
determine the 

actual command 
to be executed. 

See note i below 

 

not used 

CVR_ Conditional 
link 

not used Rows are 
displayed 

conditionally 
depending on the 

value of the 
referenced 
boolean cell 

where CVR_Label 
is the Label of the 
bookmark of the 

Boolean cell  

not used 
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Prefix Description Word Excel Visio 

CVC_ Conditional 
link 

not used Columns are 
displayed 

conditionally 
depending on the 

value of the 
referenced 
boolean cell 

where CVR_Label 
is the Label of the 
bookmark of the 

Boolean cell  

not used 

CVN_ Conditional 
link 

not used Linked from Visio : 
Label is the 

bookmark (name) 
of a cell which 

provides a TRUE 
(1) or FALSE (0) 
value, indicating 
whether a Visio 
node should be 
displayed or not 

CVN_Label is the 
Shape Name of a 

node, where  
Label  links to a 
spreadsheet cell 

with a TRUE (1) or 
FALSE (0) value 

indicating whether 
the node should 
be displayed or 

not. 
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Prefix Description Word Excel Visio 

CD_ Spreadsheet 
Display 

CD_Label where Label 
is the name of a 

spreadsheet cell or 
region. 

The bookmarked text 
is replaced by a read-
only cell field with the 

value of the cell, or 
arbitrary function 
region. See note iii 

below. 

Label is the 
bookmark (name) 
of a cell or region 
to be displayed. 

not used 

CF_ Attachment 
drop region 

CF_Label where Label 
is the name of a 

spreadsheet cell used 
to store the filename 

of a dropped 
attachment file 

Label is the 
bookmark (name) 

of a string cell 
(must not be blank 

initially) used to 
store the name of 
a file attachment 

not used 

CFN_ Attachment 
drop region 

with next 

CF_Label where Label 
is the name of a 

spreadsheet region 
used to store the 

filename of a dropped 
attachment file. 

The region must 
nominate a column of 
cells - each cell is used 

for the next file 
attachment, the row is 
incremented with each 

dropped file 

Label is the 
bookmark (name) 
of a string region 

(must not be blank 
initially) 

nominating a 
column of cells 

used to store the 
names of a set of 
file attachments 

not used 
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Prefix Description Word Excel Visio 

CG_ 

 

Attachment 
drop region 
for an image 

CG_Label where Label 
is the name of a 

spreadsheet cell used 
to store the filename 

of a dropped 
attachment image 

Label is the 
bookmark (name) 

of a string cell 
(must not be blank 

initially) used to 
store the name of 

an image 
attachment 

not used 

CH_ Hyperlink 
definition 

not used Used as the final 
value in a CCE_ 
cell link from 

word, to provide a 
hyperlink into the 

document. 

See note i below. 

not used 

CI_ Input cell CI_Label where Label 
is the name of a 
spreadsheet cell 

presented as an input 
field 

Label is the 
bookmark (name) 

of a cell to be 
presented for 

input. 

Used in excel 
display regions 
(displayed from 

Word using a CD_ 
command) to 

denote input cell 

not used 
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Prefix Description Word Excel Visio 

CJ_ Input full cell CJ_Label where Label 
is the name of a 
spreadsheet cell 

presented as an full 
input field (the input 

field extends to fill the 
table cell) 

Label is the 
bookmark (name) 

of a cell to be 
presented for 

input. 

Used in excel 
display regions 
(displayed from 

Word using a CD_ 
command) to 

denote input cell 

not used 

CO_ Output text 
from cell 

CO_Label where Label 
is the name of a 

spreadsheet cell for 
which the value is 

output as text. 

See note iii below. 

Label is the 
bookmark (name) 
of a cell of which 

the value is output 
as text. 

not used 

CT_ Title derived 
from cell 

not used Label is the 
bookmark (name) 

of a cell which 
provides the title. 

See note iv below 

CT_Label is the 
Shape Name of a 

node, where Label  
links to a 

spreadsheet cell 
which provides 
the title of the 

node 
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Prefix Description Word Excel Visio 

CV_ Input 
versioned 

cell 

CV_Label where Label 
is the name of a 
spreadsheet cell 
presented as a 

versioned input (the 
delta for the input 
field is displayed 
below the field) 

Label is the 
bookmark (name) 

of a cell to be 
presented for 

input. 

not used 

TOC_ Table of 
contents 

TOC_0 

Inserted in Word after 
Title page preceded 

and followed by page 
break. 

Instructs flwpx to 
create a table of 
contents in the 

publication for printing 
to pdf Creator 

not used not used 

SOP_ Start of Print SOP_0. 

This indicates the 
begin of the printed 

region 

not used not used 

EOP_ End of print EOP_0.  

This indicates the end 
of the printed region. 

Typically followed by 
setup-only fields, not 
intended for printing 

not used not used 
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Prefix Description Word Excel Visio 

TS_ Start of text 
segment 

TS_Label defines the 
start of an arbitrary-
length text segment 

which may be flipped 
into the utility panel 

not used not used 

TE_ End of text 
segment 

TE_Label defines the 
end of a text segment.  

Label must match 
exactly the value of 

Label in the TS_Label 
for the segment. 

not used not used 

TCS_ Start of 
conditional 

text 
segment 

TCS_Label defines the 
start of an arbitrary-
length text segment 

which is not displayed 
at the point of 

definition. 

See note v below. 

not used not used 

TCE_ End of 
conditional 

text 
segment 

TCE_Label defines the 
end of a conditional 

text segment. 

Label must match 
exactly the value of 

Label in the TCS_Label 
for the segment. 

The segment so 
defined is not 

displayed at the point 
of definition. 

See note v below. 

not used not used 
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Prefix Description Word Excel Visio 

TO_ Text 
segment 
display 

Rarely used. 

More commonly used 
as an evaluated 

bookmark through a 
CCE_ bookmark. 

See note v below. 

TO_ Label 
specifies the 

display of a text 
segment marked 

in the Word 
document through 
use of TCS_ / TCE 

bookmarks. 

See note v below. 

not used 

_00_ 

_000
_ 

Multiple 
suffix 

Allows for re-use of 
the same bookmark at 
different places in the 

document. 

See note ii below. 

Used in name 
manager for 

repetition of CCE_, 

CVC_, CVR_, CI_, 
CJ_, CK_, CLE_, 

CLV_ 

Used for Shape 
Names where 

necessary to allow 
for re-use of the 

same Shape Name 
for multiply nodes 
within the same 

chart 

CK_ Machine 
only 

not used Allows for the 
changes made on 
one machine not 

to change 
anything on 

another machine 
during a 

workgroup 
scenario. 

not used 

CLE_ Elevating 
editing 
rights 

Not used To follow To follow 
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CLV_ Elevating 
viewing 
rights 

Not used To follow To follow 

Notes: 

i The CCE_ bookmark type allows for conditional generation of the bookmark itself. In 
other words, the CCE_ bookmark is not the bookmark that will be used; rather, it 
indicates a cell in the spreadsheet that will provide the final bookmark. An example 
may illustrate this best. 

The Word document specifies a bookmark CCE_Label. The cell bookmarked (named) 
Label in the spreadsheet contains an IF statement, perhaps something like this: 
=IF($c$3, 'CH_Label2', 'CO_Label3') 

The result of this would be that if cell C3 evaluates as TRUE (1), the CCE_ bookmark 
will be replaced by CH_Label2, if FALSE (0), then replaced by CO_Label3. In other 
words, the CCE_ bookmark provides the ability to derive the final bookmark via 
conditionals in the spreadsheet, thus reacting to user input rather than being a fixed 
reference. 

ii  In Word (for bookmarks) and Visio (for Shape Names) each label may be used only 
once. Where a given label needs to be used more than once, it may be suffixed by a 
two-digit counter to provide uniqueness. For example, if you wish to output the text 
in a given cell at multiple points in the document, you may use CO_00_Label, 
CO_01_Label, CO_02_Label ... and so on. All of these will be exactly equivalent to 
CO_Label. The suffix may be used for any of the prefixes where uniqueness is 
required.  The author may use either form, as required. In other words, CO_00_Label 
is equivalent to CO_000_Label. The 3-digit variant is presented in cases where vast 
numbers of alias bookmarks are required in a single document.  

Note: multiple suffixes may NOT be used with TS_ or TCS_ text segments. 

iii  The difference between CD_ and CO_ is as follows: 

o CD_ if referring to a single cell defines a read-only cell - this is an input field 
which does not allow editing, i.e. read-only. The value of the cell may be 
selected and copied, but not changed.  Note that if CD_ is used for an Excel 
region, bookmarks in Excel define the individual cell functions. 

o CO_ outputs the value of a cell as text, in line with the surrounding text in the 
document. This text is not selectable or can be copied, and appears as if it is 
part of the surrounding text. 
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iv  This technique would only be used where the title of the node depends on user input 
or is conditional on user selections. In other words, the node shape name would 
probably link to a cell which has an =IF() or =CHOOSE() or perhaps a 
=CONCATENATE() function, which creates a conditional or composite title for the 
node. In this way, the title of the node will adjust to user selections or input. 

v A conditional text segment is used where the author wishes to be able to display a 
complex text segment conditionally at one or more places in the document. 

Where it is defined, the text segment is not displayed. Instead, it creates a text 
segment which may be referenced typically by using a CCE_ bookmark. An example 
may illustrate this best: 

The author creates two conditional text segments. The first, TCS_Car, is a paragraph 
that describes a passenger sedan motor vehicle. The second, TCS_SUV, is a 
paragraph that describes a 4x4 off_road vehicle. Neither of these paragraphs display 
where they are defined. Now, at a given point in the document, the author uses a 
CCE_ bookmark to trigger a bookmark from a spreadsheet cell which may look as 
follows: 

-IF($C$3='Off_road', TO_SUV, TO_Car) 

The result is that if the user has selected an off_road vehicle, the SUV paragraph 
displays, otherwise the sedan paragraph displays at the point where the CCE_ 
bookmark is specified. 

Conditional text segments may contain any bookmarks that are permissible at any 
other point in the document - in other words, bookmarks such as CD_, CI_ or CO_ as 
well as v_ and i_ bookmarks may be used freely in the segment. 

Note: that although not prohibited, nesting TCS_ bookmarks is not sensible in most 
cases.  It is, however, permissible to nest a TS_ / TE_ segment within a TCS_ / TCE_ 
segment. 

A TCS_ / TCE_ segment may be any length, not limited to one paragraph. 

Like a TS_ / TE segment, TCS_ / TCE_ segments may be flipped to the utility panel. 
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11 Publishing 

11.1 First Time Publishing 

Once open, you should find your last publication or it will be blank if you are a new user. 
Click on the flwpx icon and click on the publication icon that will appear. 

 

Fill in the necessary details, excel spreadsheet is not a requirement, but the Image and Chart 
folders are, even if they are empty folders. The Map label will be the name of your first 
navigational map. Once all the fields have been filled in, and the relevant documents 
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uploaded, click “Publish”. When the publication has been generated, you will receive a 
notification at the bottom of the navigation tab. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Clicking on this notification, will take you directly to the publication, alternatively you can 
find the publication in your library list, accessed by clicking on the pile of books icon in the 
navigation tab. Your new publication will appear on the left-hand side. 
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11.2 Republishing 

If you have already published a publication on flwpx and make changes afterwards, click on 
the publish icon, the publish window will appear and then in the “Publication” section, click 
on the name of your original publication from the drop down list of publications generated 
previously. 

 

You can select the icon to the far right of the Word document or Excel spreadsheet section 
and flwpx will automatically fill it in with the last files used, the image and charts folders will 
be inserted if this was the last publication uploaded.  

For new publications click on the icon to the left of the “L” and manually find the files. Once 
all the necessary fields are completed, click Publish and wait for the notification to appear. 
Once it appears, click on it and your document will open. 
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12 Sending a Publication 

Now that you have a built a complete publication, you can send it out to be filled in. To do 
this, click on the stack of books icon in the middle panel. This will take you to your library. 

If you are the author of the document or have had sending rights given to you by the 
original author, you will see the following icon next to your document. 

 

 

Click on this icon, and pick the person you wish to send the document too. 

Click on the target icon next to the person you wish to send it too. You will then see the 
following page. 

 



Private and confidential  Property of regpx 

52 
 

 

This is the license page. This allows you to control for how long someone will have access to 
your publication. “Allow forwarding” lets your recipient to send your publication to other 
people. Once the license expires they will no longer have access to it, i.e. they cannot 
change any of the fields. “Erase on expiry” removes the publication from their library. 
“Sheet view” and “Sheet edit” allows you to select what excel sheets your recipient can view 
or edit. Alternatively, select “All” and “All”. Once you have filled in the necessary fields or 
ticked the boxes, click Transmit and the publication will be sent. 

Note: The Relative Expiry is based off the values imputed into #Day and #Hours, while the 
Absolute Expiry is based off the date chosen in the calendar.  
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13 Workgroup participation 

A workgroup allows multiple parties to edit the same publication at the same time with all 

parties receiving real time edits. 

To create a workgroup, the author will need to send the form data to the workgroup 
participates. 

The author will need to enter the publication and then select the 
form data button.  

Then select the form data from the form list and click on the send 
button. That will take the author to their contact list, select the 
traget contact that requires the form data. Once the target contact 
has been selected a new window will pop up. 

 

 

 

The author will need to give the target contact the same license as they did for the 

publication. Then they must click the Add to workgroup button. Finally click the Transmit 

button to send the form data.  
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14 Printing 

Please ensure you have PDFcreator installed on your computer before you attempt to print 
a document. Go to the website: https://www.pdfforge.org/pdfcreator/download  

When you are ready to print a document from flwpx, select the logo -> print button. 

Find and select your PDFCreator and click Print. It will take a minute or longer depending on 
the size of your publication. But once it has been compiled this window will appear. 

 

Fill in all the relevant details and then Save the pdf.  

Note: If you wish to print a document please make 
sure that the rows in your Word tables do not 
exceed the length of the page minus all the 
margins. IF the row extends the length of the page, 
the document will not be printed correctly, it will 
lose all the information after the first page. 

 

Note: By creating a saving a pdf the document is no 
longer secure and can be sent to anyone. You will 
need a PDF viewer like Adobe Acrobat Reader to 
view and print the pdf. 

 

  

https://www.pdfforge.org/pdfcreator/download
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15 Worked Out Examples 

15.1 Publication with Word 

15.1.1 Modify 

Start by opening up a blank Word document. 

Personally I would modify all styles to what the author prefers. Start with the ribbon,in the 
styles section, right click on normal and click on modify. 

 

The following window will pop up, it is up to the author to decide on the text, text size, 
colour, and justification of the text of the document. 

 

Next do the same thing for your headings, ensure that the styles are all based off “normal”. 
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An author can number their headings though it’s not a requirement. To achieve numbering 
for the headings, click on the down arrow next to the multi-level numbering. 

 

At the bottom of the drop-down menu, there is a “Define New Multilevel List” click on it and 
the following window should pup-up: 

 

This will allow you to modify the numbering for each heading, just ensure that the level is 
linked to the correct style and that the next level will restart after the previous level. 
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Once all the modifications are complete, click okay. The styles section of the ribbon will 
have changed. 

From this:     

To this: 

 

The author is now ready to start typing out the word document. 

 

15.1.2 Images and Bookmarks 

To insert images into the word document, save your images in a single sub-folder of the 
folder of your word document, like so: 

 

flwpx can currently support .jpg, .png and .bmp image files. Name the images in such a way 
that you can tell what the image is without opening it. Please note that there are no spaces 
in the name, replace all spaces with an underscore “_”. 



Private and confidential  Property of regpx 

58 
 

 

Within the word document, type out a placeholder and the text that is required for the 
image such as a description. The highlighted words below are the placeholder for the image. 

 

Select the place holder then click Insert -> Bookmark 

 

 Label your bookmark identically to the image name but preceded with an “i_” (for image), 
then click “Add”. 

 



Private and confidential  Property of regpx 

59 
 

To ensure that the bookmark will only affect the placeholder, click on the “Go To” button 
and confirm that only the placeholder is selected. To ensure that the description of the 
image is below that of the image, start the description on a new line, you can also centre the 
text, flwpx will centre the text below the image.  

15.1.3 Hyperlink 

To create a hyperlink within the text, create a name for the hyperlink that will appear in the 
text, 

 

Select the placeholder and then click Insert -> Hyperlink: 

 

In this instance, the hyperlink will refer to the image that was bookmarked, click on 
“Bookmark…” to gain access to the current bookmark list. Select the correct bookmark. 
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You will notice that the “Address” has changed to reflect the current hyperlink and the text 
the hyperlink in link to is now blue and underlined. 

 

To remove this blue and underline, go back to style section of the ribbon and click the little 
arrow at the bottom. 

 

This window should appear, just scroll down until you find “Hyperlink”. 
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Hover your mouse over “Hyperlink” and click on the arrow that appear to the right, and 
then click Modify in the drop-down menu, and modify the style of the hyperlink to what you 
want. 

 

 

With the lektur built table of contents on the left. One can now navigate the publication at 
will. In this instance, there is not much to navigate as this was only created as a starting 
point of the publication. As the publication grows and becomes and more complex, 
interactivity can be included to allow users to make inputs to the publication. The image 
seen is only a thumbnail and if you were to click on it, a full sized image will appear on the 
left panel. 
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15.2 Publication with Excel 

15.2.1 Word  

Now that you know the basics of formatting, creating and publishing in flwpx, let us start 
making the publication more complex.  

Note: The following example does not include any images, but flwpx still requires an 
image/chart folder, so create an image or chart sub-folder in the folder that will house you 
Word Document and Excel spreadsheet. 

Say there is someone who wishes to request data or any information on the company, and 
to do that they will need to fill in a form to request such access. One could make it one step 
more complex and say that multiple people need access to the same data, thus one form 
can be filled out for multiple people simultaneously, which allows the company to only have 
to deal with one form instead of dozens.  

To begin, we open up a word document. Format it and add any details that are required. 

 

The information in this word document relates to GDPR regulations that come with sharing 
on information and are put in the document to protect the company. 
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15.2.2 Excel 

Next, we need to open up a spreadsheet. 

In the cases where multiple people need access we should be able to build one document 
for multiple requests, instead of one document per request. 

To start out with, we will create a field which asks the user how many requests are required 
and provide a drop down menu with the options.  

 

The small gaps that column A and D make are act as a border for the document to allow for 
printing. 

To create a drop down menu, we will create a list of options to the side, and then select all 
of them and give them a name. 

By doing this, data validation of creating a drop down menu is made easier to read. 

 Once we have the region for our drop down list named, we select the cell where we want 
the drop down menu to appear, then select Data  Data Validation. 
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A window will pop up and we will pick “list” from the “Allow” section. The source will be the 
named list we just created. 

 

To get this to appear in our document, we will need to create several bookmarks. 

To start with, we will select the entire range of our cells, and give them a sensible name. Do 
not forget to add the A & D columns to give a border. 

 

Open up the Word document and create a bookmarked placeholder for this region of cells.  

 

Take note that the only difference between the names is that the Word bookmark has the 
prefix “CD_”, this is used to tell flwpx that the document requires a range of cells here, and 
will match the Word bookmark to the Excel bookmark. 
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This will make the option selection appear in our document, but the drop down menu will 
still not allow for user input, so we will go back to the Excel spreadsheet, select the cell that 
contains the drop down menu, rename it something sensible, and add the prefix “CI_”. 

 

If you were to save both document and upload to flwpx lektur, you would have a working 
drop down menu.  

In the case that someone selects the multiple data subject request option, we will require a 
means to pop up a new option of exactly how many data requests are there. 

Pick a number, in this case we used the number four, and create a new drop down menu 
with the values 1 to 4.  

 

We only want that number of data subjects to appear in our document if the user selects 
“Multiple data subject request” from our option list. To achieve this, we will create a 
conditional cell. The highlighted cell in the image below was chosen for the conditional cell. 

 

In the formula we use an IF statement, IF cell input (C2) is equal to the “Multiple data 
subject request (H4)”, input cell (CI_002) this input name corresponds to cell C4 is valid and 
return this value, else do the other IF statement. The next IF statement says, if cell input 
(C2) is equal to “Single data subject request”, return 1, else return 2. This entire conditional 
statement will come in useful later. 
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Next, we will select another cell. In this case the adjoining cell to was used.  

 

This formula also uses an IF statement, so IF the cell input (C2) is equal to the “Multiple data 
subject request (H4)”, show the entire range of cells, else do nothing. In this case, that name 
is referring to: 

 

The “CD_” prefix is used to inform flwpx that a range of cells is required. For a conditional 
cell, the name with prefix CCE_ is used in Word. 

To allow this to show in the document, we will create a placeholder in Word and give it the 
same name as the Excel bookmark but with the extra prefix of “CCE_” to inform flwpx that 
this is a conditional region. 
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Now the information that is required for the application for the request. 

 

The title is a drop down menu and created in same manner as the other drop down menus 
above: 

 

The full stops in each of the other cells are there to ensure that flwpx picks them up as 
editable fields. The principle of how to get this to appear in the document is the same as 
above. Select the entire range of cell and give it a sensible name, and then select the entire 
range of input cells and give it a name with the prefix of “CI_”. 
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In the Word document, create a placeholder with a “CD_” prefixed bookmark. 

You might notice that there is an extra question “Show my telephone number:” and that 
telephone number is not a part of the Person_1 information block. This is because it was 
requested that the telephone number be separate and be conditional on the input of the 
user. If this request is not required, you can remove that question and add the telephone 
number to the information block. 

The method on how to achieve this request is as follows: 

Create the question, and a simple drop down menu with options of “Yes” and “No”. 

Then create a conditional statement within a separate cell. 

 

The formula is an IF statement that states, IF input of CI_007 (cell C6) is equal to “Yes” show 
the “Telephone number (incl. country code): input cell (cell C19)” set of cells, else do 
nothing. Do not forget to name the input cell with the prefix of “CI_”. Name the conditional 
cell a sensible name, then add a placeholder with the prefixed “CCE_” bookmark in the 
Word document. This conditional statement will be implemented for every person. 
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The document should add information blocks for every person who is requesting access, i.e 
if 4 people are requesting access four information blocks should appear. You will need to 
create the information block for each person, and bookmark each block. 

 

Now every person has a new information block. If you require more people, just add extra 
information blocks and increase the numbered drop down list.  

We do not want the entire number of blocks to appear in our document unless they are 
required. Therefore, we will need to use conditional statements. 

This is easy for person 3 and 4 as you can just use the input field C4 as the condition, but it is 
slightly more complicated for person 2. The information block for person 2 should appear 
when the “Joint data subject request” is selected or if the user selects “Multiple data subject 
request”  2.  

As it so happens, we have already created the fix for it. Remember that very first conditional 
statement cell we created, the one with the two IF statements? If “Joint data subject 
request” is the selected option, the cell will return 2, if the user selects “Multiple data 
subject request”  2, the cell will return 2. Thus, the conditional statements for Person 2 
will be as such. 
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The condition is if Number_of_parties (cell F3) is greater than 1, return the Person_2 
information block, else do nothing. The greater than symbol is used because if the user 
selects 3, you will still require Person 2 information block.   

You can use this conditional statement for Person 3 and Person 4, just change the value 
from 1 to 2 or 1 to 3 respectively and change the “CD_Person_2” to whatever name you 
have chosen for person 3 and person 4, just remember the prefix “CD_” in the conditional 
statement. 

For these to appear in the document, name your conditional cell some sensible name 
starting with “CD_”. Then in the Word document add a placeholder with a prefixed “CCE_” 
bookmark. Your Word document should look something like this: 
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Person_2, Person_3 and Person_4 are the conditional bookmarks. While the phone 
placeholders are the phone number conditional bookmarks. The reason for placing the 
placeholders on the same line is to reduce the gap between the information block and the 
telephone input cells in flwpx. 
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Once published the interface should look like this : 

 

If all the conditional statements hold, changing the options will change the document 
accordingly.  
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15.3 Publication with Visio / Navigational Map 

With a working and editable publication, add a navigational map. For this, you will need 
Microsoft Visio. 

You will always start with your home map. This map is the first map that will be seen when 
the publication is opened and the map the Global Map Button is linked to. 

Open up Visio, Click Basic Diagram (this ensures that you will have direct access to the most 
basic shapes i.e you do not have to go searching for them.) Select Metric Units and then 
Create. 

The default will be a grid-less landscape page. When building maps, I personally find it easier 
to use a gridded portrait page. To change the orientation, go to the ribbon > Design > Page 
Setup > Orientation > Portrait. To get gridlines, go to the ribbon > View > Show > Check the 
Grid box. 

 

Your Visio file should look like this: click on File > Info, on the right-hand side you will see a 
list of Properties, one of them is labelled Title. Rename this Title and push Enter, it will 
highlight the title, then push Ctrl + C, this will copy your title, click Save As, save your Visio 
file either in the Image folder (if you have one large folder) or in the Charts folder. In file 
name use the shortcut Ctrl + V, this will paste the copied title. Remember: If you want your 
title to be more than one word, use an underscore to split the words and not a space.  
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In this case there is a separate Chart folder where Visio files has been saved. To start 
creating a map, we will create a map for the “Data subject right request form” publication 
we built in the previous example. 

Because this publication is so small, I am going to add a “cover” page in the word document 
that will act as a home page, and then the home map will only get one block. If you look to 
the left of your Visio page you will see a line of shapes, by clicking and dragging the image 
across to your Visio page, you will get a shape you can work with. You can also create your 
own shapes. If you wish to create your own shape, make use of the line tool. To get this tool 
go to your ribbon > Home > Tools and select the drop list next to the little rectangle and 
select line. I suggest using line rather than pencil as the flwpx / svg files not always 
register/construct arcs and circles accurately, which will reduce the quality of your map in 
the flwpx interface.  
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Save all files. (Shortcut Ctrl + S). In the word document highlight the Data Request Form and 
add a bookmark to it, I suggest naming it something similar to the Visio, so if the Visio files is 
Home_map, then bookmark it Home.  

 

 

 

 

 

 

 

 

 

 

 

Open a new visio file. The next visio file I gave the title “Section_map” and created buttons 

that will link to the various sections in the document. 

 

Return to your word document, and create two placeholders with bookmarks to link to your 

maps 
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Remember to include the “v_” to inform flwpx that this is a Visio image and make sure the 

name is correct, it might be useful to copy and paste the name. It is good practise to name 

placeholders the same as the bookmark, so you can see what it is at a glance.  

Return to your Home_map Visio file and select the block, then in the ribbon > Insert > Link  

create a double hyperlink as follows : 

 

The double hyperlink talks first to the Word bookmark and then to the Visio file bookmark 

and is separated by a colon. The first bit “Home” will direct the publication to that 

bookmark, which in this case is the front page, while the second bit “v_Section_map” will 

change the home_map to the section_map. Separate the two links with a colon “:”.Once 
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your hyperlink is added, save your file. Go File > Export > Change File Type > SVG > Save as. 

The file name will pick up the title of the file. Remember: Save it within the Chart folder. You 

may now close the Home_map Visio file. 

 

In your section_map Visio file, the home button’s hyperlink will be Home:v_Home_map. 

This will return the map to the home map. The GDPR and the Details buttons hyperlinks will 

be a bit different. 

Go to your word document and add a bookmark for the GDPR and Details sections. 

 

In the Visio file select the GDPR block and give it the hyperlink of “GDPR” and then give the 

details block the hyperlink of “Details”, exactly like the bookmark in word. 

 

Once you have put in all your hyperlinks, save your file. Go File > Export > Change File Type > 

SVG > Save as. The file name will pick up the title of the file. Remember: Save it within the 

Chart folder. You can now close the Section_map Visio file.  

Save your word document and close it.  

Open up flwpx, click the flwpx icon > new publication > fill in the necessary details. Look for 

the third last option called Map Label, in this entry field put the name of your first map. In 

this case, it is Home_map. 
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 Click Publish. Wait a few moments, and your publication with a map will be generated. 

Visio is not used solely for maps; it can be used to create interactive diagrams within your 

publication. If you wish to place an interactive diagram within your publication, a few 

additional steps need to be taken. In your Word document, place a “i_visio_image” 

bookmark where you wish the image to appear and export your visio file to JPG. Remember: 

Save your .jpg in the image folder and NOT the chart folder. 
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15.3.1 Interactive Visio Image 

To create an interactive image open up a Visio file and create your image. In this example, I 
created an image of the Project Life Cycle. 

 

Remember to go to File>Info and fill in the “title” section and save the visio files with the 
same name. 

To create the lines, I used the connector tool, you can find this in the ribbon. Home > Tools > 

Icon  . Then click on the corner where you want the line to begin and drag the line to 
the next corner. 

Then in your word document, add the information you require that coincides with this 
image. For this example, I will show you how to get one of the diamonds to work as they all 
follow the same procedure. 
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Above is the text that links to the Initiation diamond in the Visio file. Also, note the 
“project_life” above the “Initiation”, this is the placeholder for the .svg file, and it has the 
bookmark, “v_project_life”. Highlight “Initiation” and give it the bookmark “Initiation” or 
similar and save your word document. 

Return to the Visio file and give the “Initiation” diamond the hyperlink “Initiation” or as 

bookmarked in Word. Save your Visio file and export it twice: one as an .svg and once as a 

.jpg. Remember: Save your .jpg in the image folder and NOT the chart folder, if you are 

using to separate folders. 

In flwpx, the .jpg will produce a thumbnail in your media panel and if you click on it will 
open the .svg in the utility panel. The “Initiation” diamond will be interactive, if you click on 
it the media panel will jump to the information about initiation. 
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The image used in the example above is a simple one; you can make much more complex 
ones. For instance: 

 

 

 

This map was created in Visio using the line tool. Each region is selectable for the media 

panel to display information about that region.  
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15.3.2 Conditional Visio Maps 

If you want only parts of a Visio image to display depending on what the user inputs into 
your publication, you can achieve this by giving your Visio shapes conditional names. 

Using the base map above as an example, to allow the first block “Check client risk profile” 
and “Exchange Size: Low” with the linking line to appear only if the client’s risk level is low 
and simultaneously exclude “Exchange Size: Medium” and “Exchange Size: High”. 

To do this we need an excel spreadsheet. 

 

 

 

The user will see the Transaction Value and be able to input a number. 

 Cell with number: Name: “CI_something” 

 Highlighted region: Name: “Transact_value” 

 Word document: Bookmark of “CD_Transact_value” (Save and close your Word file) 

The red cells are your conditional cells. Each with the following formula and cell name 

Formula: 

 Low risk: =IF(CI_Transaction_value>=100000,TRUE,FALSE) 

 Medium risk: =IF(AND(CI_Transaction_value<100000,CI_Transaction_value>=50000),TRUE,FALSE) 

 High risk: =IF(AND(CI_Transaction_value<50000,CI_Transaction_value>=5000),TRUE,FALSE) 
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Cell name: 

 Low risk: low_risk 

 Medium risk: medium_risk 

 High risk: high_risk 

Save your Excel file. 

Return to your Visio file, click on the “Exchange Size: Low” block and then in the ribbon: 
Developer > Shape Design > Shape name. 

If you do not have the Developer tab, File > Options > Customize Ribbon and tick the 
developer check box. 
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Give your shape the name “CVN_low_risk” 

 

In this case there is a “01” in the name, this is because the line connecting the “Check client 
risk profile” and “Exchange Size: Low” blocks has been given the same conditional 
statement. (Names need to be unique in Visio, Word and Excel. To re-use names insert a 
number between the prefix and the name separated by an underscore “_”.) When you have 
two or more names that are the same, you must add “_00_” between the “CC” and the 
name. (Note: this applies to duplicated images in your Word file as well). You can do the 
same thing to the other blocks, but leave the “Check client risk profile” block unnamed, as it 
is always visible.  

Save your Visio file and export it to .svg. Now if the user selects a value larger than 100 000, 
the only part of the map that will show is the “Check client risk profile” and “Exchange Size: 
Low” blocks with the connecting line. 
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15.4 Using Conditional exclusion to allow or remove regional editing rights in 
a publication 

Apart from setting viewing and editing rights to the Excel worksheets at the time of 
transmitting the publication, rights can also be set within a worksheet depending on the 
conditions that are resolved with an IF statement. 

The IF statement can be simple or complex, but must resolve to choice of two options: do 
this or do that. The CCE_Label command is an instruction to flwpx to resolve the statement 
in the cell to which the label refers and follow the command that results. 

As a straightforward example: Labe a cell “Financial_Plan_Cond” and insert an IF statement 
such as : 

=IF(CLE_12,"CI_Financial_Plan","CO_Financial_Plan")  

 

Provide rights to a user by inserting TRUE in a cell and labelling the cell “CLE_12”. This tells 
flwpx that the user who has been assigned full editing rights to sheet 12 may edit regions in 
other sheets IF that region has been given the label “CCE_Financial_Plan_Cond” 
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Label regions in other sheets for which CLE_12 does not have editing rights that you would 
like the user to be able to edit with “CCE_00_Financial_Plan_Cond”, if the user does not 
have editing rights for sheet 12 the area is view only. 

 

As a more complex example: Label a cell “Jan_20_Cond” and insert an IF statement such as: 

=IF(OR(AND(Management!BN114=Management!AJ100,CLE_12),Jan_20),"CIR_Jan_20_Cond"
,"CD_Jan_20_Cond") 
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Three conditions are presented in the statement:  

i)  cell BN114 (which is a drop down list) must equal AJ100; AND  

 

ii)  the user has full rights to worksheet 12 (insert TRUE in a cell and label cell as CLE_12), OR  
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iii)  cell labelled Jan_20 resolves as TRUE:FALSE 

 

If the AND condition is TRUE, OR if “Jan_20” is TRUE, a “CIR_Jan_20_Cond” as an editable 
region results, otherwise a “CD_ Jan_20_Cond” as a display only region results 
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15.5 Using Conditional exclusion in Word  

Conditionality in Word can be used in a number of ways. In this worked example, we are 

displaying one of three regions laid out in Excel depending on the drop list selection made. 

Create three conditional IF statements in Excel and label them.   
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In Word label three bookmarks with the same labels as the name of the conditionals in Excel 

using the prefix CCE_ 

Thus which region will be displayed in flwpx, is dependent on the drop list value that is 

chosen.  
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15.6 Using conditionals to allow regions to appear only when predetermined 
input made 

In your named region, label the cell that will trigger a TRUE/FALSE, in the example below a 
tick box will resolve as TRUE/FALSE and has been labelled as CIR_Entry20.  
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Apply conditional row exclusion that must appear when the tick box is TRUE, in the example 
below I have labelled a region CVR_CIR_Entry20.  

  



Private and confidential  Property of regpx 

93 
 

In the region, CVR_CIR_Entry20, a dropdown list for -/Yes/No is selectable. Outside of the 
display region, create a TRUE/FALSE cell that resolves TRUE when Yes for “Block Chain 
Analysis” is selected. 
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Again, outside of the display region, create a second TRUE/FALSE cell that resolves TRUE 
when No for “Block Chain Analysis” is selected. 
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Label your two TRUE/FALSE cells. In the example, one is “BlockChain3” and the other 
“BlockChain3a” 
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 Apply your row validation to the areas that are to appear when the condition cell results in 
TRUE. In the example, CVR_BlockChain3 and CVR_BlockChain3a have been applied, resulting 
in “Any Suspicious activity” appearing when “Yes” is selected for “Block Chain Analysis” and 
“Report failure of “Block Chain Analysis” when “No” is selected. 
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15.7 Reset button 

Continuing with the above example, insert a 0 in a cell within a named region and label the 
cell CR_ followed by three characters, in this example we have used CR_BWF. The “0” 
indicates that all TRUEs will be reset to FALSE and any drop list will be reset to the first item 
which in our example is a “-“. 

 

The reset button can be placed in 
multiple places in the publication by 
inserting numbering between the CR_ 
and the three characters to create 
uniqueness. Alternatively, a new reset 
button can be created by using a 
different set of three characters. 
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Label the areas that are to be reset with XX_ followed by the same three characters used for 

your reset button. Do not include areas that need to retain their data. XX_ can be used in 

multiple places in the publication by inserting numbering between the XX_ and the three 

characters used to create uniqueness.  
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Appendix A: Currently Implement Excel functions 

This table holds all the current Excel functions that flwpx supports. 

Function Name Type and description 

ABS Function 
Math and trigonometry: Returns the 
absolute value of a number  

ACOS Function 
Math and trigonometry: Returns the 
arccosine of a number 

AND function  
Logical: Returns TRUE if all of its arguments 
are TRUE 

ASIN function  
Math and trigonometry: Returns the 
arcsine of a number 

ATAN function  
Math and trigonometry: Returns the 
arctangent of a number 

AVERAGE function  
Statistical: Returns the average of its 
arguments 

AVERAGEIF function  
Statistical: Returns the average (arithmetic 
mean) of all the cells in a range that meet a 
given criteria 

CEILING function  
Math and trigonometry: Rounds a number 
to the nearest integer or to the nearest 
multiple of significance 

CHAR function  
Text: Returns the character specified by the 
code number 

CHOOSE function  
Lookup and reference: Chooses a value 
from a list of values 

COLUMN function  
Lookup and reference: Returns the column 
number of a reference 

COLUMNS function  
Lookup and reference: Returns the number 
of columns in a reference 
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Function Name Type and description 

CONCAT function  
 

Text: Combines the text from multiple 
ranges and/or strings, but it doesn't provide 
the delimiter or IgnoreEmpty arguments. 

This function isn't available in Excel 2016 
for Mac. 

CONCATENATE function  
Text: Joins several text items into one text 
item 

CONCATENATE function  
Text: Joins several text items into one text 
item 

COUNT function  
Statistical: Counts how many numbers are 
in the list of arguments 

COUNTIF function  
Statistical: Counts the number of cells 
within a range that meet the given criteria 

DATE function  
Date and time: Returns the serial number 
of a particular date 

DAY function  
Date and time: Converts a serial number to 
a day of the month 

DAYS function  
Date and time: Returns the number of days 
between two dates 

DAYS360 function  
Date and time: Calculates the number of 
days between two dates based on a 360-
day year 

EDATE function  
Date and time: Returns the serial number 
of the date that is the indicated number of 
months before or after the start date 

EOMONTH function  
Date and time: Returns the serial number 
of the last day of the month before or after 
a specified number of months 

EVEN function  
Math and trigonometry: Rounds a number 
up to the nearest even integer 

EXP function  
Math and trigonometry: Returns e raised 
to the power of a given number 

FALSE function  Logical: Returns the logical value FALSE 
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Function Name Type and description 

FIND, FINDB functions  
Text: Finds one text value within another 
(case-sensitive) 

FLOOR function  

Compatibility: Rounds a number down, 
toward zero 

In Excel 2007 and Excel 2010, this is a Math 
and trigonometry function. 

FORMULATEXT function  
Lookup and reference: Returns the formula 
at the given reference as text 

IF function  Logical: Specifies a logical test to perform 

IFERROR function  
Logical: Returns a value you specify if a 
formula evaluates to an error; otherwise, 
returns the result of the formula 

INDIRECT function  
Lookup and reference: Returns a reference 
indicated by a text value 

INT function  
Math and trigonometry: Rounds a number 
down to the nearest integer 

ISEVEN function  
Information: Returns TRUE if the number is 
even 

ISODD function  
Information: Returns TRUE if the number is 
odd 

LEFT, LEFTB functions  
Text: Returns the leftmost characters from 
a text value 

LEN, LENB functions  
Text: Returns the number of characters in a 
text string 

LN function  
Math and trigonometry: Returns the 
natural logarithm of a number 

LOG10 function  
Math and trigonometry: Returns the base-
10 logarithm of a number 

LOOKUP function  
Lookup and reference: Looks up values in a 
vector or array 

MAX function  
Statistical: Returns the maximum value in a 
list of arguments 
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Function Name Type and description 

MIN function  
Statistical: Returns the minimum value in a 
list of arguments 

MOD function  
Math and trigonometry: Returns the 
remainder from division 

MONTH function  
Date and time: Converts a serial number to 
a month 

NETWORKDAYS function  
Date and time: Returns the number of 
whole workdays between two dates 

NOT function  Logical: Reverses the logic of its argument 

OR function  
Logical: Returns TRUE if any argument is 
TRUE 

PI function  
Math and trigonometry: Returns the value 
of pi 

POWER function  
Math and trigonometry: Returns the result 
of a number raised to a power 

RADIANS function  
Math and trigonometry: Converts degrees 
to radians 

RAND function  
Math and trigonometry: Returns a random 
number between 0 and 1 

RIGHT, RIGHTB functions  
Text: Returns the rightmost characters 
from a text value 

ROUND function  
Math and trigonometry: Rounds a number 
to a specified number of digits 

ROUNDDOWN function  
Math and trigonometry: Rounds a number 
down, toward zero 

ROUNDUP function  
Math and trigonometry: Rounds a number 
up, away from zero 

ROW function  
Lookup and reference: Returns the row 
number of a reference 

ROWS function  
Lookup and reference: Returns the number 
of rows in a reference 
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Function Name Type and description 

SEARCH, SEARCHB functions  
Text: Finds one text value within another 
(not case-sensitive) 

SIGN function  
Math and trigonometry: Returns the sign 
of a number 

SIN function  
Math and trigonometry: Returns the sine 
of the given angle 

SQRT function  
Math and trigonometry: Returns a positive 
square root 

SUM function  
Math and trigonometry: Adds its 
arguments 

SUMIF function  
Math and trigonometry: Adds the cells 
specified by a given criteria 

TAN function  
Math and trigonometry: Returns the 
tangent of a number 

TODAY function  
Date and time: Returns the serial number 
of today's date 

TRUE function  Logical: Returns the logical value TRUE 

TRUNC function  
Math and trigonometry: Truncates a 
number to an integer 

UPPER function  Text: Converts text to uppercase 

VALUE function  
Text: Converts a text argument to a 
number 

VLOOKUP function  
Lookup and reference: Looks in the first 
column of an array and moves across the 
row to return the value of a cell 

WEEKDAY function  
Date and time: Converts a serial number to 
a day of the week 

WORKDAY function  
Date and time: Returns the serial number 
of the date before or after a specified 
number of workdays 
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Function Name Type and description 

XOR function  

 

Logical: Returns a logical exclusive OR of all 
arguments 

YEAR function  
Date and time: Converts a serial number to 
a year 
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Appendix B: All unimplemented Excel functions 

This table contains all Excel functionality that does not currently work in the flwpx 
environment, but can be implemented if the need arises and is great enough. 

Function Name Type and description 

ACCRINT function  
Financial: Returns the accrued interest for a 
security that pays periodic interest 

ACCRINTM function  
Financial: Returns the accrued interest for a 
security that pays interest at maturity 

ACOSH function  
Math and trigonometry: Returns the 
inverse hyperbolic cosine of a number 

ACOT function  
 

Math and trigonometry: Returns the 
arccotangent of a number 

ACOTH function  
 

Math and trigonometry: Returns the 
hyperbolic arccotangent of a number 

AGGREGATE function  
Math and trigonometry: Returns an 
aggregate in a list or database 

ADDRESS function  
Lookup and reference: Returns a reference 
as text to a single cell in a worksheet 

AMORDEGRC function  
Financial: Returns the depreciation for each 
accounting period by using a depreciation 
coefficient 

AMORLINC function  
Financial: Returns the depreciation for each 
accounting period 

ARABIC function  
 

Math and trigonometry: Converts a Roman 
number to Arabic, as a number 

AREAS function  
Lookup and reference: Returns the number 
of areas in a reference 

ASC function  

Text: Changes full-width (double-byte) 
English letters or katakana within a 
character string to half-width (single-byte) 
characters 

ASINH function  
Math and trigonometry: Returns the 
inverse hyperbolic sine of a number 
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Function Name Type and description 

ATAN2 function  
Math and trigonometry: Returns the 
arctangent from x- and y-coordinates 

ATANH function  
Math and trigonometry: Returns the 
inverse hyperbolic tangent of a number 

AVEDEV function  
Statistical: Returns the average of the 
absolute deviations of data points from 
their mean 

AVERAGEA function  
Statistical: Returns the average of its 
arguments, including numbers, text, and 
logical values 

AVERAGEIFS function  
Statistical: Returns the average (arithmetic 
mean) of all cells that meet multiple 
criteria.  

BAHTTEXT function  
Text: Converts a number to text, using the 
ß (baht) currency format 

BASE function  
Math and trigonometry: Converts a 
number into a text representation with the 
given radix (base) 

BESSELI function  
Engineering: Returns the modified Bessel 
function In(x) 

BESSELJ function  
Engineering: Returns the Bessel function 
Jn(x) 

BESSELK function  
Engineering: Returns the modified Bessel 
function Kn(x) 

BESSELY function  
Engineering: Returns the Bessel function 
Yn(x) 

BETADIST function  

Compatibility: Returns the beta cumulative 
distribution function 

In Excel 2007, this is a Statistical function. 

BETA.DIST function  
 

Statistical: Returns the beta cumulative 
distribution function 
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Function Name Type and description 

BETAINV function  

Compatibility: Returns the inverse of the 
cumulative distribution function for a 
specified beta distribution 

In Excel 2007, this is a Statistical function. 

BETA.INV function  
 

Statistical: Returns the inverse of the 
cumulative distribution function for a 
specified beta distribution 

BIN2DEC function  
Engineering: Converts a binary number to 
decimal 

BIN2HEX function  
Engineering: Converts a binary number to 
hexadecimal 

BIN2OCT function  
Engineering: Converts a binary number to 
octal 

BINOMDIST function  

Compatibility: Returns the individual term 
binomial distribution probability 

In Excel 2007, this is a Statistical function. 

BINOM.DIST function  
 

Statistical: Returns the individual term 
binomial distribution probability 

BINOM.DIST.RANGE function  
 

Statistical: Returns the probability of a trial 
result using a binomial distribution 

BINOM.INV function  
 

Statistical: Returns the smallest value for 
which the cumulative binomial distribution 
is less than or equal to a criterion value 

BITAND function  
 

Engineering: Returns a 'Bitwise And' of two 
numbers 

BITLSHIFT function  
 

Engineering: Returns a value number 
shifted left by shift_amount bits 

BITOR function  
 

Engineering: Returns a bitwise OR of 2 
numbers 

BITRSHIFT function  
 

Engineering: Returns a value number 
shifted right by shift_amount bits 
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Function Name Type and description 

BITXOR function  
 

Engineering: Returns a bitwise 'Exclusive 
Or' of two numbers 

CALL function  
Add-in and Automation: Calls a procedure 
in a dynamic link library or code resource 

CEILING.MATH function  
 

Math and trigonometry: Rounds a number 
up, to the nearest integer or to the nearest 
multiple of significance 

CEILING.PRECISE function  

Math and trigonometry: Rounds a number 
the nearest integer or to the nearest 
multiple of significance. Regardless of the 
sign of the number, the number is rounded 
up.  

CELL function  

Information: Returns information about 
the formatting, location, or contents of a 
cell 

This function is not available in Excel 
Online. 

CHIDIST function  

Compatibility: Returns the one-tailed 
probability of the chi-squared distribution 

Note: In Excel 2007, this is a Statistical 
function. 

CHIINV function  

Compatibility: Returns the inverse of the 
one-tailed probability of the chi-squared 
distribution 

Note: In Excel 2007, this is a Statistical 
function. 

CHITEST function  

Compatibility: Returns the test for 
independence 

Note: In Excel 2007, this is a Statistical 
function. 

CHISQ.DIST function  
 

Statistical: Returns the cumulative beta 
probability density function 

CHISQ.DIST.RT function  
 

Statistical: Returns the one-tailed 
probability of the chi-squared distribution 
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Function Name Type and description 

CHISQ.INV function  
 

Statistical: Returns the cumulative beta 
probability density function 

CHISQ.INV.RT function  
 

Statistical: Returns the inverse of the one-
tailed probability of the chi-squared 
distribution 

CHISQ.TEST function  
 

Statistical: Returns the test for 
independence 

CLEAN function  
Text: Removes all nonprintable characters 
from text 

CODE function  
Text: Returns a numeric code for the first 
character in a text string 

COMBIN function  
Math and trigonometry: Returns the 
number of combinations for a given 
number of objects 

COMBINA function  
 

Math and trigonometry:  
Returns the number of combinations with 
repetitions for a given number of items 

COMPLEX function  
Engineering: Converts real and imaginary 
coefficients into a complex number 

CONFIDENCE function  

Compatibility: Returns the confidence 
interval for a population mean 

In Excel 2007, this is a Statistical function. 

CONFIDENCE.NORM function  
 

Statistical: Returns the confidence interval 
for a population mean 

CONFIDENCE.T function  
 

Statistical: Returns the confidence interval 
for a population mean, using a Student's t 
distribution 

CONVERT function  
Engineering: Converts a number from one 
measurement system to another 

CORREL function  
Statistical: Returns the correlation 
coefficient between two data sets 

COSH function  
Math and trigonometry: Returns the 
hyperbolic cosine of a number 
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COT function  
 

Math and trigonometry: Returns the 
hyperbolic cosine of a number 

COTH function  

 

Math and trigonometry: Returns the 
cotangent of an angle 

COUNTA function  
Statistical: Counts how many values are in 
the list of arguments 

COUNTBLANK function  
Statistical: Counts the number of blank 
cells within a range 

COUNTIF function  
Statistical: Counts the number of cells 
within a range that meet the given criteria 

COUNTIFS function  
Statistical: Counts the number of cells 
within a range that meet multiple criteria 

COUPDAYBS function  
Financial: Returns the number of days from 
the beginning of the coupon period to the 
settlement date 

COUPDAYS function  
Financial: Returns the number of days in 
the coupon period that contains the 
settlement date 

COUPDAYSNC function  
Financial: Returns the number of days from 
the settlement date to the next coupon 
date 

COUPNCD function  
Financial: Returns the next coupon date 
after the settlement date 

COUPNUM function  
Financial: Returns the number of coupons 
payable between the settlement date and 
maturity date 

COUPPCD function  
Financial: Returns the previous coupon 
date before the settlement date 

COVAR function  

Compatibility: Returns covariance, the 
average of the products of paired 
deviations 

In Excel 2007, this is a Statistical function. 
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COVARIANCE.P function  

 

Statistical: Returns covariance, the average 
of the products of paired deviations 

COVARIANCE.S function  

 

Statistical: Returns the sample covariance, 
the average of the products deviations for 
each data point pair in two data sets 

CRITBINOM function  

Compatibility: Returns the smallest value 
for which the cumulative binomial 
distribution is less than or equal to a 
criterion value 

In Excel 2007, this is a Statistical function. 

CSC function  

 

Math and trigonometry: Returns the 
cosecant of an angle 

CSCH function  

 

Math and trigonometry: Returns the 
hyperbolic cosecant of an angle 

CUBEKPIMEMBER function  

Cube: Returns a key performance indicator 
(KPI) name, property, and measure, and 
displays the name and property in the cell. 
A KPI is a quantifiable measurement, such 
as monthly gross profit or quarterly 
employee turnover, used to monitor an 
organization's performance. 

CUBEMEMBER function  
Cube: Returns a member or tuple in a cube 
hierarchy. Use to validate that the member 
or tuple exists in the cube. 

CUBEMEMBERPROPERTY function  

Cube: Returns the value of a member 
property in the cube. Use to validate that a 
member name exists within the cube and 
to return the specified property for this 
member. 

CUBERANKEDMEMBER function  

Cube: Returns the nth, or ranked, member 
in a set. Use to return one or more 
elements in a set, such as the top sales 
performer or top 10 students. 

 

  



Private and confidential  Property of regpx 

112 
 

Function Name Type and description 

CUBESET function  

Cube: Defines a calculated set of members 
or tuples by sending a set expression to the 
cube on the server, which creates the set, 
and then returns that set to Microsoft 
Office Excel. 

CUBESETCOUNT function  Cube: Returns the number of items in a set. 

CUBEVALUE function  
Cube: Returns an aggregated value from a 
cube. 

CUMIPMT function  
Financial: Returns the cumulative interest 
paid between two periods 

CUMPRINC function  
Financial: Returns the cumulative principal 
paid on a loan between two periods 

DATEDIF function  

Date and time: Calculates the number of 
days, months, or years between two dates. 
This function is useful in formulas where 
you need to calculate an age. 

DATEVALUE function  
Date and time: Converts a date in the form 
of text to a serial number 

DAVERAGE function  
Database: Returns the average of selected 
database entries 

DB function  
Financial: Returns the depreciation of an 
asset for a specified period by using the 
fixed-declining balance method 

DBCS function  

 

Text: Changes half-width (single-byte) 
English letters or katakana within a 
character string to full-width (double-byte) 
characters 

DCOUNT function  
Database: Counts the cells that contain 
numbers in a database 

DCOUNTA function  
Database: Counts nonblank cells in a 
database 
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DDB function  

Financial: Returns the depreciation of an 
asset for a specified period by using the 
double-declining balance method or some 
other method that you specify 

DEC2BIN function  
Engineering: Converts a decimal number to 
binary 

DEC2HEX function  
Engineering: Converts a decimal number to 
hexadecimal 

DEC2OCT function  
Engineering: Converts a decimal number to 
octal 

DECIMAL function  

 

Math and trigonometry: Converts a text 
representation of a number in a given base 
into a decimal number 

DEGREES function  
Math and trigonometry: Converts radians 
to degrees 

DELTA function  
Engineering: Tests whether two values are 
equal 

DEVSQ function  
Statistical: Returns the sum of squares of 
deviations 

DGET function  
Database: Extracts from a database a single 
record that matches the specified criteria 

DISC function  
Financial: Returns the discount rate for a 
security 

DMAX function  
Database: Returns the maximum value 
from selected database entries 

DMIN function  
Database: Returns the minimum value 
from selected database entries 

DOLLAR function  
Text: Converts a number to text, using the 
$ (dollar) currency format 

DOLLARDE function  
Financial: Converts a dollar price, 
expressed as a fraction, into a dollar price, 
expressed as a decimal number 
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DOLLARFR function  
Financial: Converts a dollar price, 
expressed as a decimal number, into a 
dollar price, expressed as a fraction 

DPRODUCT function  
Database: Multiplies the values in a 
particular field of records that match the 
criteria in a database 

DSTDEV function  
Database: Estimates the standard deviation 
based on a sample of selected database 
entries 

DSTDEVP function  
Database: Calculates the standard 
deviation based on the entire population of 
selected database entries 

DSUM function  
Database: Adds the numbers in the field 
column of records in the database that 
match the criteria 

DURATION function  
Financial: Returns the annual duration of a 
security with periodic interest payments 

DVAR function  
Database: Estimates variance based on a 
sample from selected database entries 

DVARP function  
Database: Calculates variance based on the 
entire population of selected database 
entries 

EFFECT function  
Financial: Returns the effective annual 
interest rate 

ENCODEURL function  

 

Web: Returns a URL-encoded string 

This function is not available in Excel 
Online. 

ERF function  Engineering: Returns the error function 

ERF.PRECISE function  

 
Engineering: Returns the error function 

ERFC function  
Engineering: Returns the complementary 
error function 
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ERFC.PRECISE function  

 

Engineering: Returns the complementary 
ERF function integrated between x and 
infinity 

ERROR.TYPE function  
Information: Returns a number 
corresponding to an error type 

EUROCONVERT function  

Add-in and Automation: Converts a 
number to euros, converts a number from 
euros to a euro member currency, or 
converts a number from one euro member 
currency to another by using the euro as an 
intermediary (triangulation). 

EXACT function  
Text: Checks to see if two text values are 
identical 

EXPON.DIST function  

 

Statistical: Returns the exponential 
distribution 

EXPONDIST function  

Compatibility: Returns the exponential 
distribution 

In Excel 2007, this is a Statistical function. 

FACT function  
Math and trigonometry: Returns the 
factorial of a number 

FACTDOUBLE function  
Math and trigonometry: Returns the 
double factorial of a number 

F.DIST function  

 

Statistical: Returns the F probability 
distribution 

FDIST function  

Compatibility: Returns the F probability 
distribution 

In Excel 2007, this is a Statistical function. 

F.DIST.RT function  

 

Statistical: Returns the F probability 
distribution 

FILTERXML function  

 

Web: Returns specific data from the XML 
content by using the specified XPath 

This function is not available in Excel 
Online. 
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F.INV function  

 

Statistical: Returns the inverse of the F 
probability distribution 

F.INV.RT function  

 

Statistical: Returns the inverse of the F 
probability distribution 

FINV function  
Statistical: Returns the inverse of the F 
probability distribution 

FISHER function  
Statistical: Returns the Fisher 
transformation 

FISHERINV function  
Statistical: Returns the inverse of the Fisher 
transformation 

FIXED function  
Text: Formats a number as text with a fixed 
number of decimals 

FLOOR.MATH function  

 

Math and trigonometry: Rounds a number 
down, to the nearest integer or to the 
nearest multiple of significance 

FLOOR.PRECISE function  

Math and trigonometry: Rounds a number 
the nearest integer or to the nearest 
multiple of significance. Regardless of the 
sign of the number, the number is rounded 
up.  

FORECAST function  

Statistical: Returns a value along a linear 
trend 

In Excel 2016, this function is replaced with 
FORECAST.LINEAR as part of the new 
Forecasting functions, but it's still available 
for compatibility with earlier versions. 

FORECAST.ETS function  

 

Statistical: Returns a future value based on 
existing (historical) values by using the AAA 
version of the Exponential Smoothing (ETS) 
algorithm 

This function isn't available in Excel 2016 
for Mac. 
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FORECAST.ETS.CONFINT function  

 

Statistical: Returns a confidence interval for 
the forecast value at the specified target 
date 

This function isn't available in Excel 2016 
for Mac. 

FORECAST.ETS.SEASONALITY function  

 

Statistical: Returns the length of the 
repetitive pattern Excel detects for the 
specified time series 

This function isn't available in Excel 2016 
for Mac. 

FORECAST.ETS.STAT function  

 

Statistical: Returns a statistical value as a 
result of time series forecasting 

This function isn't available in Excel 2016 
for Mac.* 

FORECAST.LINEAR function  

 

Statistical: Returns a future value based on 
existing values 

This function isn't available in Excel 2016 
for Mac. * 

FREQUENCY function  
Statistical: Returns a frequency distribution 
as a vertical array 

F.TEST function  

 
Statistical: Returns the result of an F-test 

FTEST function  

Compatibility: Returns the result of an F-
test 

In Excel 2007, this is a Statistical function. 

FV function  
Financial: Returns the future value of an 
investment. * 

FVSCHEDULE function  
Financial: Returns the future value of an 
initial principal after applying a series of 
compound interest rates 

GAMMA function  

 

Statistical: Returns the Gamma function 
value 
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GAMMA.DIST function  

 
Statistical: Returns the gamma distribution 

GAMMADIST function  

Compatibility: Returns the gamma 
distribution 

In Excel 2007, this is a Statistical function. 

GAMMA.INV function  

 

Statistical: Returns the inverse of the 
gamma cumulative distribution 

GAMMAINV function  

Compatibility: Returns the inverse of the 
gamma cumulative distribution 

In Excel 2007, this is a Statistical function. 

GAMMALN function  
Statistical: Returns the natural logarithm of 
the gamma function, G(x) 

GAMMALN.PRECISE function  

 

Statistical: Returns the natural logarithm of 
the gamma function, G(x) 

GAUSS function  

 

Statistical: Returns 0.5 less than the 
standard normal cumulative distribution 

GCD function  
Math and trigonometry: Returns the 
greatest common divisor 

GEOMEAN function  Statistical: Returns the geometric mean 

GESTEP function  
Engineering: Tests whether a number is 
greater than a threshold value 

GETPIVOTDATA function  
Lookup and reference: Returns data stored 
in a PivotTable report 

GROWTH function  
Statistical: Returns values along an 
exponential trend 

HARMEAN function  Statistical: Returns the harmonic mean 
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HEX2BIN function  
Engineering: Converts a hexadecimal 
number to binary 

HEX2DEC function  
Engineering: Converts a hexadecimal 
number to decimal 

HEX2OCT function  
Engineering: Converts a hexadecimal 
number to octal 

HLOOKUP function  

Lookup and reference: Looks in the top 
row of an array and returns the value of the 
indicated cell 

HOUR function  
Date and time: Converts a serial number to 
an hour 

HYPERLINK function  

Lookup and reference: Creates a shortcut 
or jump that opens a document stored on a 
network server, an intranet, or the Internet 

HYPGEOM.DIST function  
Statistical: Returns the hypergeometric 
distribution 

HYPGEOMDIST function  

Compatibility: Returns the hypergeometric 
distribution 

In Excel 2007, this is a Statistical function. 

IFNA function  

 

Logical: Returns the value you specify if the 
expression resolves to #N/A, otherwise 
returns the result of the expression 

IFS function  

 

Logical: Checks whether one or more 
conditions are met and returns a value that 
corresponds to the first TRUE condition. 

This function isn't available in Excel 2016 
for Mac. 
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IMABS function  
Engineering: Returns the absolute value 
(modulus) of a complex number 

IMAGINARY function  
Engineering: Returns the imaginary 
coefficient of a complex number 

IMARGUMENT function  
Engineering: Returns the argument theta, 
an angle expressed in radians 

IMCONJUGATE function  
Engineering: Returns the complex 
conjugate of a complex number 

IMCOS function  
Engineering: Returns the cosine of a 
complex number 

IMCOSH function  

 

Engineering: Returns the hyperbolic cosine 
of a complex number 

IMCOT function  

 

Engineering: Returns the cotangent of a 
complex number 

IMCSC function  

 

Engineering: Returns the cosecant of a 
complex number 

IMCSCH function  

 

Engineering: Returns the hyperbolic 
cosecant of a complex number 

IMDIV function  
Engineering: Returns the quotient of two 
complex numbers 

IMEXP function  
Engineering: Returns the exponential of a 
complex number 

IMLN function  
Engineering: Returns the natural logarithm 
of a complex number 
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IMLOG10 function  
Engineering: Returns the base-10 logarithm 
of a complex number 

IMLOG2 function  
Engineering: Returns the base-2 logarithm 
of a complex number 

IMPOWER function  
Engineering: Returns a complex number 
raised to an integer power 

IMPRODUCT function  
Engineering: Returns the product of 
complex numbers 

IMREAL function  
Engineering: Returns the real coefficient of 
a complex number 

IMSEC function  

 

Engineering: Returns the secant of a 
complex number 

IMSECH function  

 

Engineering: Returns the hyperbolic secant 
of a complex number 

IMSIN function  
Engineering: Returns the sine of a complex 
number 

IMSINH function  

 

Engineering: Returns the hyperbolic sine of 
a complex number 

IMSQRT function  
Engineering: Returns the square root of a 
complex number 

IMSUB function  
Engineering: Returns the difference 
between two complex numbers 

IMSUM function  
Engineering: Returns the sum of complex 
numbers 

IMTAN function  

 

Engineering: Returns the tangent of a 
complex number 
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INDEX function  
Lookup and reference: Uses an index to 
choose a value from a reference or array 

INFO function  

Information: Returns information about 
the current operating environment 

This function is not available in Excel 
Online. 

INTERCEPT function  
Statistical: Returns the intercept of the 
linear regression line 

INTRATE function  
Financial: Returns the interest rate for a 
fully invested security 

IPMT function  
Financial: Returns the interest payment for 
an investment for a given period 

IRR function  
Financial: Returns the internal rate of 
return for a series of cash flows 

ISBLANK function  
Information: Returns TRUE if the value is 
blank 

ISERR function  
Information: Returns TRUE if the value is 
any error value except #N/A 

ISERROR function  
Information: Returns TRUE if the value is 
any error value 

ISFORMULA function  

 

Information: Returns TRUE if there is a 
reference to a cell that contains a formula 

ISLOGICAL function  
Information: Returns TRUE if the value is a 
logical value 

ISNA function  
Information: Returns TRUE if the value is 
the #N/A error value 
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ISNONTEXT function  
Information: Returns TRUE if the value is 
not text 

ISNUMBER function  
Information: Returns TRUE if the value is a 
number 

ISREF function  
Information: Returns TRUE if the value is a 
reference 

ISTEXT function  
Information: Returns TRUE if the value is 
text 

ISO.CEILING function  

 

Math and trigonometry: Returns a number 
that is rounded up to the nearest integer or 
to the nearest multiple of significance 

ISOWEEKNUM function  

 

Date and time: Returns the number of the 
ISO week number of the year for a given 
date 

ISPMT function  
Financial: Calculates the interest paid 
during a specific period of an investment 

JIS function  

Text: Changes half-width (single-byte) 
characters within a string to full-width 
(double-byte) characters 

KURT function  
Statistical: Returns the kurtosis of a data 
set 

LARGE function  
Statistical: Returns the k-th largest value in 
a data set 

LCM function  
Math and trigonometry: Returns the least 
common multiple 

LINEST function  
Statistical: Returns the parameters of a 
linear trend 
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LOG function  
Math and trigonometry: Returns the 
logarithm of a number to a specified base 

LOGEST function  
Statistical: Returns the parameters of an 
exponential trend 

LOGINV function  
Compatibility: Returns the inverse of the 
lognormal cumulative distribution 

LOGNORM.DIST function  

 

Statistical: Returns the cumulative 
lognormal distribution 

LOGNORMDIST function  
Compatibility: Returns the cumulative 
lognormal distribution 

LOGNORM.INV function  

 

Statistical: Returns the inverse of the 
lognormal cumulative distribution 

LOOKUP function  
Lookup and reference: Looks up values in a 
vector or array 

LOWER function  Text: Converts text to lowercase 

MATCH function  
Lookup and reference: Looks up values in a 
reference or array 

MAXA function  

Statistical: Returns the maximum value in a 
list of arguments, including numbers, text, 
and logical values 

MAXIFS function  

 

Statistical: Returns the maximum value 
among cells specified by a given set of 
conditions or criteria 

This function isn't available in Excel 2016 
for Mac. 

MDETERM function  
Math and trigonometry: Returns the 
matrix determinant of an array 
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MDURATION function  

Financial: Returns the Macauley modified 
duration for a security with an assumed par 
value of $100 

MEDIAN function  
Statistical: Returns the median of the given 
numbers 

MID, MIDB functions  

Text: Returns a specific number of 
characters from a text string starting at the 
position you specify 

MINIFS function  

 

Statistical: Returns the minimum value 
among cells specified by a given set of 
conditions or criteria.  

This function isn't available in Excel 2016 
for Mac. 

MINA function  

Statistical: Returns the smallest value in a 
list of arguments, including numbers, text, 
and logical values 

MINUTE function  
Date and time: Converts a serial number to 
a minute 

MINVERSE function  
Math and trigonometry: Returns the 
matrix inverse of an array 

MIRR function  

Financial: Returns the internal rate of 
return where positive and negative cash 
flows are financed at different rates 

MMULT function  
Math and trigonometry: Returns the 
matrix product of two arrays 

MODE function  

Compatibility: Returns the most common 
value in a data set 

In Excel 2007, this is a Statistical function. 
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MODE.MULT function  

 

Statistical: Returns a vertical array of the 
most frequently occurring, or repetitive 
values in an array or range of data 

MODE.SNGL function  

 

Statistical: Returns the most common value 
in a data set 

MROUND function  
Math and trigonometry: Returns a number 
rounded to the desired multiple 

MULTINOMIAL function  
Math and trigonometry: Returns the 
multinomial of a set of numbers 

MUNIT function  

 

Math and trigonometry: Returns the unit 
matrix or the specified dimension 

N function  
Information: Returns a value converted to 
a number 

NA function  Information: Returns the error value #N/A 

NEGBINOM.DIST function  

 

Statistical: Returns the negative binomial 
distribution 

NEGBINOMDIST function  

Compatibility: Returns the negative 
binomial distribution 

In Excel 2007, this is a Statistical function. 

NETWORKDAYS.INTL function  

 

Date and time: Returns the number of 
whole workdays between two dates using 
parameters to indicate which and how 
many days are weekend days 

NOMINAL function  
Financial: Returns the annual nominal 
interest rate 

NORM.DIST function  

 

Statistical: Returns the normal cumulative 
distribution 
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NORMDIST function  

Compatibility: Returns the normal 
cumulative distribution 

In Excel 2007, this is a Statistical function. 

NORMINV function  
Statistical: Returns the inverse of the 
normal cumulative distribution 

NORM.INV function  

 

Compatibility: Returns the inverse of the 
normal cumulative distribution 

Note: In Excel 2007, this is a Statistical 
function. 

NORM.S.DIST function  

 

Statistical: Returns the standard normal 
cumulative distribution 

NORMSDIST function  

Compatibility: Returns the standard normal 
cumulative distribution 

In Excel 2007, this is a Statistical function. 

NORM.S.INV function  

 

Statistical: Returns the inverse of the 
standard normal cumulative distribution 

NORMSINV function  

Compatibility: Returns the inverse of the 
standard normal cumulative distribution 

In Excel 2007, this is a Statistical function. 

NOW function  
Date and time: Returns the serial number 
of the current date and time 

NPER function  
Financial: Returns the number of periods 
for an investment 

NPV function  

Financial: Returns the net present value of 
an investment based on a series of periodic 
cash flows and a discount rate 

NUMBERVALUE function  

 

Text: Converts text to number in a locale-
independent manner 
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OCT2BIN function  
Engineering: Converts an octal number to 
binary 

OCT2DEC function  
Engineering: Converts an octal number to 
decimal 

OCT2HEX function  
Engineering: Converts an octal number to 
hexadecimal 

ODD function  
Math and trigonometry: Rounds a number 
up to the nearest odd integer 

ODDFPRICE function  
Financial: Returns the price per $100 face 
value of a security with an odd first period 

ODDFYIELD function  
Financial: Returns the yield of a security 
with an odd first period 

ODDLPRICE function  
Financial: Returns the price per $100 face 
value of a security with an odd last period 

ODDLYIELD function  
Financial: Returns the yield of a security 
with an odd last period 

OFFSET function  
Lookup and reference: Returns a reference 
offset from a given reference 

PDURATION function  

 

Financial: Returns the number of periods 
required by an investment to reach a 
specified value 

PEARSON function  
Statistical: Returns the Pearson product 
moment correlation coefficient 

PERCENTILE.EXC function  

 

Statistical: Returns the k-th percentile of 
values in a range, where k is in the range 
0..1, exclusive 
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PERCENTILE.INC function  

 

Statistical: Returns the k-th percentile of 
values in a range 

PERCENTILE function  

Compatibility: Returns the k-th percentile 
of values in a range 

In Excel 2007, this is a Statistical function. 

PERCENTRANK.EXC function  

 

Statistical: Returns the rank of a value in a 
data set as a percentage (0..1, exclusive) of 
the data set 

PERCENTRANK.INC function  

 

Statistical: Returns the percentage rank of 
a value in a data set 

PERCENTRANK function  

Compatibility: Returns the percentage rank 
of a value in a data set 

In Excel 2007, this is a Statistical function. 

PERMUT function  
Statistical: Returns the number of 
permutations for a given number of objects 

PERMUTATIONA function  

 

Statistical: Returns the number of 
permutations for a given number of objects 
(with repetitions) that can be selected from 
the total objects 

PHI function  

 

Statistical: Returns the value of the density 
function for a standard normal distribution 

PHONETIC function  
Text: Extracts the phonetic (furigana) 
characters from a text string 

PMT function  
Financial: Returns the periodic payment for 
an annuity 

POISSON.DIST function  

 

Statistical: Returns the Poisson distribution 
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POISSON function  

Compatibility: Returns the Poisson 
distribution  

In Excel 2007, this is a Statistical function. 

PPMT function  

Financial: Returns the payment on the 
principal for an investment for a given 
period 

PRICE function  

Financial: Returns the price per $100 face 
value of a security that pays periodic 
interest 

PRICEDISC function  
Financial: Returns the price per $100 face 
value of a discounted security 

PRICEMAT function  

Financial: Returns the price per $100 face 
value of a security that pays interest at 
maturity 

PROB function  
Statistical: Returns the probability that 
values in a range are between two limits 

PRODUCT function  
Math and trigonometry: Multiplies its 
arguments 

PROPER function  
Text: Capitalizes the first letter in each 
word of a text value 

PV function  
Financial: Returns the present value of an 
investment 

QUARTILE function  

Compatibility: Returns the quartile of a 
data set 

In Excel 2007, this is a Statistical function. 

QUARTILE.EXC function  

 

Statistical: Returns the quartile of the data 
set, based on percentile values from 0..1, 
exclusive 
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QUARTILE.INC function  

 

Statistical: Returns the quartile of a data 
set 

QUOTIENT function  
Math and trigonometry: Returns the 
integer portion of a division 

RANDBETWEEN function  
Math and trigonometry: Returns a random 
number between the numbers you specify 

RANK.AVG function  

 

Statistical: Returns the rank of a number in 
a list of numbers  

RANK.EQ function  

 

Statistical: Returns the rank of a number in 
a list of numbers 

RANK function  

Compatibility: Returns the rank of a 
number in a list of numbers 

In Excel 2007, this is a Statistical function. 

RATE function  
Financial: Returns the interest rate per 
period of an annuity 

RECEIVED function  
Financial: Returns the amount received at 
maturity for a fully invested security 

REGISTER.ID function  

Add-in and Automation: Returns the 
register ID of the specified dynamic link 
library (DLL) or code resource that has been 
previously registered 

REPLACE, REPLACEB functions  Text: Replaces characters within text 

REPT function  Text: Repeats text a given number of times 

ROMAN function  
Math and trigonometry: Converts an arabic 
numeral to roman, as text 
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RRI function  

 

Financial: Returns an equivalent interest 
rate for the growth of an investment 

RSQ function  

Statistical: Returns the square of the 
Pearson product moment correlation 
coefficient 

RTD function  

Lookup and reference: Retrieves real-time 
data from a program that supports COM 
automation 

SEC function  

 

Math and trigonometry: Returns the 
secant of an angle 

SECH function  

 

Math and trigonometry: Returns the 
hyperbolic secant of an angle 

SECOND function  
Date and time: Converts a serial number to 
a second 

SERIESSUM function  
Math and trigonometry: Returns the sum 
of a power series based on the formula 

SHEET function  

 

Information: Returns the sheet number of 
the referenced sheet 

SHEETS function  

 

Information: Returns the number of sheets 
in a reference 

SINH function  
Math and trigonometry: Returns the 
hyperbolic sine of a number 

SKEW function  
Statistical: Returns the skewness of a 
distribution 
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Function Name Type and description 

SKEW.P function  

 

Statistical: Returns the skewness of a 
distribution based on a population: a 
characterization of the degree of 
asymmetry of a distribution around its 
mean 

SLN function  
Financial: Returns the straight-line 
depreciation of an asset for one period 

SLOPE function  
Statistical: Returns the slope of the linear 
regression line 

SMALL function  
Statistical: Returns the k-the smallest value 
in a data set 

SQL.REQUEST function  

Add-in and Automation: Connects with an 
external data source and runs a query from 
a worksheet, then returns the result as an 
array without the need for macro 
programming 

SQRTPI function  
Math and trigonometry: Returns the 
square root of (number * pi) 

STANDARDIZE function  Statistical: Returns a normalized value 

STDEV function  
Compatibility: Estimates standard 
deviation based on a sample 

STDEV.P function  

 

Statistical: Calculates standard deviation 
based on the entire population  

STDEV.S function  

 

Statistical: Estimates standard deviation 
based on a sample 

STDEVA function  

Statistical: Estimates standard deviation 
based on a sample, including numbers, text, 
and logical values 
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Function Name Type and description 

STDEVP function  

Compatibility: Calculates standard 
deviation based on the entire population 

In Excel 2007, this is a Statistical function. 

STDEVPA function  

Statistical: Calculates standard deviation 
based on the entire population, including 
numbers, text, and logical values 

STEYX function  

Statistical: Returns the standard error of 
the predicted y-value for each x in the 
regression 

SUBSTITUTE function  
Text: Substitutes new text for old text in a 
text string 

SUBTOTAL function  
Math and trigonometry: Returns a subtotal 
in a list or database 

SUMIFS function  
Math and trigonometry: Adds the cells in a 
range that meet multiple criteria 

SUMPRODUCT function  

Math and trigonometry: Returns the sum 
of the products of corresponding array 
components 

SUMSQ function  
Math and trigonometry: Returns the sum 
of the squares of the arguments 

SUMX2MY2 function  

Math and trigonometry: Returns the sum 
of the difference of squares of 
corresponding values in two arrays 

SUMX2PY2 function  

Math and trigonometry: Returns the sum 
of the sum of squares of corresponding 
values in two arrays 

SUMXMY2 function  

Math and trigonometry: Returns the sum 
of squares of differences of corresponding 
values in two arrays 
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Function Name Type and description 

SWITCH function  

 

Logical: Evaluates an expression against a 
list of values and returns the result 
corresponding to the first matching value. If 
there is no match, an optional default value 
may be returned. 

This function isn't available in Excel 2016 
for Mac. 

SYD function  

Financial: Returns the sum-of-years' digits 
depreciation of an asset for a specified 
period 

T function  Text: Converts its arguments to text 

TANH function  
Math and trigonometry: Returns the 
hyperbolic tangent of a number 

TBILLEQ function  
Financial: Returns the bond-equivalent 
yield for a Treasury bill 

TBILLPRICE function  
Financial: Returns the price per $100 face 
value for a Treasury bill 

TBILLYIELD function  
Financial: Returns the yield for a Treasury 
bill 

T.DIST function  

 

Statistical: Returns the Percentage Points 
(probability) for the Student t-distribution 

T.DIST.2T function  

 

Statistical: Returns the Percentage Points 
(probability) for the Student t-distribution 

T.DIST.RT function  

 

Statistical: Returns the Student's t-
distribution 

TDIST function  
Compatibility: Returns the Student's t-
distribution 
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Function Name Type and description 

TEXT function  
Text: Formats a number and converts it to 
text 

TEXTJOIN function  

 

Text: Combines the text from multiple 
ranges and/or strings, and includes a 
delimiter you specify between each text 
value that will be combined. If the delimiter 
is an empty text string, this function will 
effectively concatenate the ranges. 

This function isn't available in Excel 2016 
for Mac. 

TIME function  
Date and time: Returns the serial number 
of a particular time 

TIMEVALUE function  
Date and time: Converts a time in the form 
of text to a serial number 

T.INV function  

 

Statistical: Returns the t-value of the 
Student's t-distribution as a function of the 
probability and the degrees of freedom 

T.INV.2T function  

 

Statistical: Returns the inverse of the 
Student's t-distribution 

TINV function  
Compatibility: Returns the inverse of the 
Student's t-distribution 

TRANSPOSE function  
Lookup and reference: Returns the 
transpose of an array 

TREND function  
Statistical: Returns values along a linear 
trend 

TRIM function  Text: Removes spaces from text 

TRIMMEAN function  
Statistical: Returns the mean of the interior 
of a data set 
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Function Name Type and description 

T.TEST function  

 

Statistical: Returns the probability 
associated with a Student's t-test 

TTEST function  

Compatibility: Returns the probability 
associated with a Student's t-test 

In Excel 2007, this is a Statistical function. 

TYPE function  
Information: Returns a number indicating 
the data type of a value 

UNICHAR function  

 

Text: Returns the Unicode character that is 
references by the given numeric value 

UNICODE function  

 

Text: Returns the number (code point) that 
corresponds to the first character of the 
text 

VAR function  

Compatibility: Estimates variance based on 
a sample 

In Excel 2007, this is a Statistical function. 

VAR.P function  

 

Statistical: Calculates variance based on the 
entire population 

VAR.S function  

 

Statistical: Estimates variance based on a 
sample 

VARA function  

Statistical: Estimates variance based on a 
sample, including numbers, text, and logical 
values 

VARP function  

Compatibility: Calculates variance based on 
the entire population 

In Excel 2007, this is a Statistical function. 

VARPA function  

Statistical: Calculates variance based on the 
entire population, including numbers, text, 
and logical values 
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Function Name Type and description 

VDB function  

Financial: Returns the depreciation of an 
asset for a specified or partial period by 
using a declining balance method 

WEBSERVICE function  

 

Web: Returns data from a web service. 

This function is not available in Excel 
Online. 

WEEKNUM function  

Date and time: Converts a serial number to 
a number representing where the week 
falls numerically with a year 

WEIBULL function  

Compatibility: Calculates variance based on 
the entire population, including numbers, 
text, and logical values 

In Excel 2007, this is a Statistical function. 

WEIBULL.DIST function  

 

Statistical: Returns the Weibull distribution 

WORKDAY.INTL function  

 

Date and time: Returns the serial number 
of the date before or after a specified 
number of workdays using parameters to 
indicate which and how many days are 
weekend days 

XIRR function  

Financial: Returns the internal rate of 
return for a schedule of cash flows that is 
not necessarily periodic 

XNPV function  

Financial: Returns the net present value for 
a schedule of cash flows that is not 
necessarily periodic 

YEARFRAC function  

Date and time: Returns the year fraction 
representing the number of whole days 
between start_date and end_date 
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Function Name Type and description 

YIELD function  
Financial: Returns the yield on a security 
that pays periodic interest 

YIELDDISC function  

Financial: Returns the annual yield for a 
discounted security; for example, a 
Treasury bill  

YIELDMAT function  
Financial: Returns the annual yield of a 
security that pays interest at maturity 

Z.TEST function  

 

Statistical: Returns the one-tailed 
probability-value of a z-test 

ZTEST function  

Compatibility: Returns the one-tailed 
probability-value of a z-test 

In Excel 2007, this is a Statistical function. 

 


